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INTRODUCTION 

In this User Manual, you will find the instructions on how to utilize the screens in the Client Portal and 
detailed information on the use of the Client Portal to create and administer your Virtual Machines and 
Bare Metal Servers. 

To make navigation easier, the table of contents is set up to mimic the tab and menu order that you see 
inside of the Client Portal. You can hold the ctrl key and click any topic in the table of contents above to 
jump to the desired topic. 

This guide assumes you are familiar with the basic concepts of managed hosting services. 

CLIENT PORTAL OVERVIEW 

The Client Portal has been designed for the utmost ease of use. We have brought cloud and bare metal 
features into one central portal, giving you more access and control over your infrastructure. It offers all 
the necessary administrative tools for Clients. 

This section of the Client Portal discusses the basics of accessing and navigating the main features of the 
Client Portal.   

ACCESSING THE CLIENT PORTAL 

You can access the Client Portal at https://admin.phoenixnap.com/wap-pncpadmin-shell/login. 

You will be contacted via email when your account is created, but before you can log in, you have to 
contact Support for your username and initial password. This information is not sent via email due to 
security concerns. You should have this information available when you sign in to the Client Portal. 

To log in to the Client Portal: 

1. Browse to https://admin.phoenixnap.com/wap-pncpadmin-shell/login. 
2. Enter your Username and Password in the appropriate fields. 
3. Click Sign In. 

After signing in, you are immediately taken to the Dashboard page. 

If you forgot your password, follow these steps: 

NOTE: We recommend to allow pop-ups while accessing and using the Client Portal. 

 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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1. Browse to https://admin.phoenixnap.com/wap-pncpadmin-shell/login. 
2. Click “Forgot your password?” below the Sign In button. 
3. Enter your email and click OK.  

 

 
4. The system sends sign-in instructions to your email address. 

Resetting your password: 

1. Sign in to the Client Portal. 
2. Open the My Account mega menu. 
3. Click the User Profiles. 
4. Locate the User requiring a password reset. 
5. Click the Actions link under the Manage heading. 
6. Click Reset Password. 
7. Type in the new password in the New Password field and confirm it by re-typing it in the Re-

enter Password field. 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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8. Click Update to commit the changes. 

If you are an existing customer signing in to the new portal for the first time, use this procedure to 
migrate credentials and associated common metadata: 

1. Browse to https://admin.phoenixnap.com/wap-pncpadmin-shell/login. 
2. Select ‘Click here to Migrate your Credentials before logging in. 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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3. Click the type of account you have and enter your Username and Password in the appropriate 

fields. 
4. Click Submit. 

CLIENT PORTAL HOME PAGE 

The image below is a representation of the phoenixNAP Client Portal Home Page. 
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Each numbered area has a different purpose: 

1. Dashboard. The Dashboard serves as the landing page and provides you with a quick overview 
of what's going on with your account. It gives you a quick visual summary of your account, 
showing your devices, their status, where they're located, and how much bandwidth they 
have used since your last invoice. 

2. Manage. The Manage mega menu provides all the necessary tools which help you manage 
your bare metal and cloud services.  

3. Reports. The Reports mega menu provides detailed reports to allow you to view a summary 
of actions, usage, and allocations in an easily searchable format. The following reports are 
available: 

• Action Log. The Action Log displays a list of actions performed by users, such as 
creating VMs or adding a new user. The list is customizable by date-range and can be 
filtered using a variety of options. 

• Allocation Report. The Allocation Report displays the allocated hardware as well as 
the percent of your allocations currently in use. 

• Billing Report. The Billing Report provides you with a summary of your bill; How many 
consumable items (VCPUs, Operating Systems, Backups, IP addresses, and other 
items you are billed for using) you used during the billing cycle, and itemizes the costs 
for those consumables. 

• Usage Report. The Usage Report displays what is currently in use by each VM, 
including RAM, VCPUs, OS, Backup, and the number of IPs.  

4. My Account. Provides information on the administrative tools used to maintain your account, 
any accounts under you, and user profiles. 

5. Products & Services. An overview of phoenixNAP and its global IT solutions. 
6. Dashboard Information Area. For more information, see Dashboard. 
7. phoenixNAP Logo. By clicking the phoenixNAP logo, you can go back to the Client Portal 

Home Page. 
8. Header Area. In the header area, you will find information and options like: 

• User Name 
• Support. By clicking Support a drop-down menu with the following options will 

open: 
o Submit a Ticket. A new window will appear. Provide the necessary 

information concerning your issue and click Submit. 
o All Tickets. Opens a new screen, where you can browse through your old 

Tickets or submit a new one. 
o Live Chat. Chat with Cloud Support members regarding any concerns you 

may have. 
o Email Support. Report any technical issues you may encounter, and tech 

support will fix it as soon as possible.  
• My Preferences. My Preferences offers you a choice between two User Interfaces: 

o System Administrator 
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o Graphical User 
• Sign Out. If you wish to sign out of the Client Portal, click Sign Out located at the 

upper-right corner of the screen.  
9. Recent Tickets. In the Recent Tickets area, you may view the status of your recently submitted 

tickets or submit new ones by clicking the Submit Ticket icon. Filter your view by clicking the 
View drop-down menu and choosing between: 

• Open/On Hold Tickets 
• Closed Tickets 
• All Tickets  

 
10. Footer Area. The footer, or extreme bottom, of the Client Portal screen, provides you with a 

link to the company home page, the phone number to call for support, the email address for 
help, and an additional link for bug reporting. 

MY PREFERENCES 

The My Preferences screen allows you to select a default view for all screens you encounter in the Client 
Portal. You will be given a choice between two User Interface types: 

• System Administrator. Also known as List Display, this UI offers more tree-like window 
selectors, lists, tables, and details are displayed sooner. 

• Graphical User. Also known as Block Display, this UI offers more icons and grouping, in 
addition to tooltips.  

Set your preference by clicking your desired option, and then click Update. 

 

You can choose a view type when you are on individual screens using the Display icons.

 

NOTE: Click Return to Listing to be redirected to the Support Tickets screen.  
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SUPPORT OPTIONS 

By clicking Support on the Client Portal home page, a drop-down menu with several options will appear. 

Choose from:  

• Submit a Ticket. A new window will appear. Provide the necessary information concerning 
your issue and click Submit. 

• All Tickets. Opens a new screen, where you can browse through your old Tickets or submit a 
new one. 

• Live Chat. Chat with Support team members regarding any concerns you may have. 
• Email Support. Send an email to Cloud Support and report any technical issues you may 

encounter, and tech support will fix it as soon as possible. 

Regarding any concerns, call Support at 1 855 330 1509 or Sales at 1 877 588 5918. 

SUBMIT A SUPPORT REQUEST 

There are several ways you can submit a Support Request: 

• Method #1. Click the Submit Ticket icon on the Dashboard (landing page). 
• Method #2. Open the Support drop-down menu and choose Submit a Ticket. 
• Method #3. Alternatively, open the My Account mega menu, click Support Tickets under the 

My Account section, and select the Submit Ticket button.  

No matter what method you choose, a pop-up window opens:  
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1. Fill in the Subject and Message fields. Make sure to include as much detail as possible, 
including the exact text of any error messages received. Add CC field is optional.  

2. Choose the problematic Device from the drop-down menu.  
3. Select the service by typing in the service ID or description. Suggested-devices list appears 

when you click the field.  
4. Click Send when ready.  

DASHBOARD 

The Dashboard is the landing page that gives you a quick overview of what is going on with your account. 
It gives you a quick visual summary of your account, showing your devices, their status, where they're 
located, and how much bandwidth they have used since your last invoice.  

 

The Dashboard screen displays summary data divided into categories for your convenience. Each category 
is displayed within a box on the screen with labels and contents, as described in the following sections. 

NO DEVICES 
If you don't have any devices yet, you will receive the "You Have No Devices Yet" notice with an option 
to Create a Virtual Machine or Create a Bare Metal Server. Click one of these two icons to create the 
desired device. 
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My Devices: lists your devices, their name, and type (Bare Metal Servers, VMs, Firewalls). Click a device 
name to open a new page where you can manage and modify that device. 

Status: states the current status of your devices (Online or Offline). 

Node: names the node to which a specific device is assigned to. This shows you the location of the device. 

Bandwidth Since Last Invoice Date: the Bandwidth section contains data on bandwidth used, expressed 
in Kilobytes (kB), Megabytes (MB), and Gigabytes (GB), since the last invoice date. 

MANAGE 

The Manage mega menu provides all the necessary administrative tools which help you maintain your 
account. This section includes:  

• Combined Functions 
• Bare Metal 
• Public Cloud 
• Virtual Private Data Center 
• Additional Cloud Services 

COMBINED FUNCTIONS 
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In the Combined Functions section of the Manage mega menu, you will find all the tools necessary to 
manage your physical and virtual assets. 

DEVICE LISTING 

On the Device Listing screen, you can manage your devices and check their status and configuration. Here 
you will find your VMs, Bare Metal Servers, and Dedicated Firewalls.  

To access Device Listing:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing under the Combined Functions heading.  

 

Filter 

You may filter out your devices by: 

• Node. Choose one of your nodes to view the devices assigned to it.  
• View. Filter out the specific type of device you wish to view.  
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• Search. Enter the name of one of your devices in the Search Bar to further filter out results. 
There is no need for a "submit" or "go" button, the search begins when you type your first 
character.  

 

Display  

You can change the view by clicking the Display icon. 

 

Choose between:  

1. List Display. Displays the details and includes:  

• Device Name.  
• Type. The device type is indicated by the Icon next to Device Name.  
• Status. Shows whether the device is Online or Offline.  
• Node. Shows to which node the device is assigned to.  
• IP. This describes the IP Address usage. Hover over to get a list of Private IPs and 

those Originating from Public Pools, if any.  
• Bandwidth In.  
• Bandwidth Out.  
• Tags. Shows any existing tags associated with the device.  

 
 

2. Block Display. Fewer details are displayed right away, and include:  
• Device Name.  
• Type. Indicated by the Icon next to Device Name.  
• Status. Shows whether the device is Online or Offline  



©2021, phoenixNAP, LLC 

 

Page 15 of 124 

 

In Block Display View, click a blank space within a device card to display its Status Bar in the right corner 
of the screen.  

• Power Status. Shows whether the 
device is Online or Offline.  

• Node. Shows to which node the 
device is assigned to. 

• Name. Device name. 
• Description. Shows device 

description, if any. 
• VM ID. The unique ID number 

assigned to the VM by the system. 
• Connection. 
• OS. The OS installed on VM. 
• Version. Version of OS. 
• VMWare Tools. This only displays if 

your VMWare Tools are out of date. 
View the Updating VMWare Tools 
topic for more information. 

• # VCPU. Number of Virtual Central 
Processing Units (VCPUs) installed in 
the Virtual Machine. 

• Memory (RAM). How many 
Gigabytes (GB) of RAM memory is 
assigned to the device. 

• Storage. Primary and Secondary 
storage expressed in Gigabytes (GB). 

• Public IP's. VM's Public IP Addresses. 
• Private IP's. VM's Private IP Addresses. 
• Cost for VM/hr. 
• Tags. Tags are used to sort your VMs into manageable categories and containers. 

Available Actions 

Right-click or select a device and click the Available Actions icon to open the Available Actions drop-down 
menu. If you select multiple devices, use the Available Group Actions button to perform an action on 
multiple devices at once.  

Depending on the type of device, various functions can be performed: 

• Add/Modify Tag(s). Create new or search existing tags.  
• Clone VM. The Clone function creates an exact copy of an existing Virtual Machine.  
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• Console. The easiest way to access your VM is through the console link provided in the VM 
Listing.  

• Delete VM. To permanently and irretrievably delete a configured Virtual Machine, use this 
link.  

• Export VM to Image Library. This allows you to create an image of an existing VM, enabling 
you to quickly create VMs from images with your specific software already installed.  

• Manage VM. If you need to make changes to an existing VM, first power off the VM (if it isn't 
already), then visit this link.  

• Power Off a Device. If you are no longer using a VM or Bare Metal Server, but wish to retain 
the Device and all of its data and settings for future use, you will use the Power Off function. 
This reduces the cost for that device when you do not need it, but reserves it for quick 
implementation when you do. You will still be charged for the device at a reduced rate while 
it is powered off.  

• Power On a Device. When you are ready to begin using a powered-off device again, you may 
perform virtually the same steps to power it back on.  

• Reboot. There are many differing opinions about why, when, and how you should reboot any 
Server or Virtual Machine. Some companies have a schedule and reboot Windows servers 
monthly. Some only reboot when critical patches are released, others reboot when a kernel 
update is necessary or when installing new software packages. 
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Regardless of all the differing opinions, servers and VMs occasionally need to be rebooted. It 
is probably a good idea for you to have a strategy for rebooting your VMs. Take into 
consideration your up-time needs, your end-user's needs, and your business needs when 
developing that strategy.  

Actions specific for Dedicated Firewalls and/or Bare Metal Servers:  

• Assign to. You can assign a Bare Metal Server to a specific user.  
• Manage Bare Metal/Dedicated Firewall. This will take you to the Manage My Device screen, 

where you can modify the BMS.  
• OS Reload. For Custom OS Reloads, you will need to submit a ticket and provide any additional 

details needed to our Support team.  

You can access many of these functions by right-clicking a device in Device Listing. There may also be 
buttons or links, such as the Available Actions button, that will take you to some of these functions from 
the Device Listing screen as well.  

ADD OR MODIFY TAG(S) 

• To add an existing tag, choose one from the drop-down menu.  
• To add a new tag, enter a tag name in the field, and click the Plus icon.  

Add as many tags as you need, and press Save when you are finished.  
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CLONE VM 

The Clone function creates an exact copy of an existing VM. 

To make a clone of a VM: 

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing under the Combined Functions heading.  
4. Identify the VM you want to make a clone of. Right-click that VM and select Clone VM from 

the menu.  
5. Select the number of clones you want to create from the drop-down menu.  
6. Click Clone to start the process.  

 

7. Enter the VM Username and Password in the appropriate fields.  
8. Click OK.  

You can monitor the progress of the setup on the Provisioning Tasks screen.  

 

 

NOTE: If you clone a VM that has public IP addresses, the resulting copy of that VM will have NO public IP 
addresses assigned to it. Use the Manage a VM tool to add public IP addresses to the cloned VMs. 
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CONSOLE 

Use the Console button to access your device to perform administrative tasks, install software, and 
perform other functions. The tool is especially useful if your server appears unresponsive.  

You must have pop-ups allowed for the admin domain to access the Console.  

To access the Console:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing under the Combined Functions heading.  
4. Right-click a device. 
5. In the drop-down menu, click Console. The Console loads in a new window. 

Should you choose, you may also log in to your Virtual Machine via SSH or RDP for Windows machines. 
Use the Public IP assigned to your Device to access the server in this fashion.  

 

DELETE A VM 

You may delete any VM at any time, provided the VM has been powered off. 

To delete a Virtual Machine:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing under the Combined Functions heading.  
4. Locate the VM you wish to delete in the listing. Use a filter if necessary.  
5. Right-click the VM you wish to delete and select Delete VM.  
6. Click the Yes, Delete VM button to confirm the deletion.  

 

EXPORT VM TO IMAGE LIBRARY 

The Client Portal allow you to make images of VMs. An image is a copy of a VM that includes all the 
customized software you have installed. Images are useful if you want to be able to quickly deploy several 
identical VMs that are already pre-installed with all your customized settings. 

 

NOTE: If you intend to use RDP or SSH to access your Device, you will need to configure your Firewall to 
allow access to Ports 22 (SSH) or 3389 (RDP). 

 

Deleting a VM is permanent! 
You will not be able to retrieve the VM or its data after the deletion. 
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To export a VM as an image: 

1. Open the Device Listing screen from the Manage mega menu.  
2. Power Off the VM you want to make an image of. 
3. Right-click the VM and select Export VM to Image Library from the menu. 
4. Select the Power VM back on when export completes checkbox if you want the VM to turn 

back on when you're done imaging the VM. 
5. Enter a name for the image in the New Image Name field. 
6. Click Create VM Template. 
7. Click OK.  

 

You can view the progress of the export on the Provisioning Tasks screen or in the Image Library itself. 

MANAGE VM 

To make changes to an existing VM, use the Manage VM feature.  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing in the Combined Functions section.  
4. Locate the VM you wish to modify in the listing. Use View filter if necessary.  
5. Right-click the VM you wish to modify and click Manage VM in the menu.  
6. Make changes to any options needing changes:  

https://help.phoenixnap.com/Login


©2021, phoenixNAP, LLC 

 

Page 21 of 124 

 

• Power Status. Turns the VM on or off.  
• Description (optional). Enter a description for your VM in the text box. This can help 

you identify the VM. If you have or plan on having multiple VMs, we recommend you 
add a description.  

• Node. The location your VM is assigned to. 
• Name of VM. This is how the VM will appear in the VM Listing. No spaces and/or 

special characters are allowed in the VM name.  
• Tags (optional). If you wish to assign an already existing tag to the new VM, choose 

that tag name from the drop-down menu. If you wish to create a new tag to assign to 
the VM, enter the tag name, and click the plus sign.  

• OS & Version. The installed system and version. Cannot be changed. VMWare Tool 
info is shown here as well.  

• #VCPUs. Select how many Virtual Central Processing Units to assign to the Virtual 
Machine. You may either move the slider to select or enter a number in the box given 
to the right. You may choose either 1, 2, 4, or 8 VCPUs when modifying a VM.  

• Memory (RAM). Select how many Gigabytes of RAM to install in the VM. Move the 
slider to select or enter a number in the box given to the right.  

• Storage. A Primary Storage and Secondary Storage icon is displayed. Click Edit on the 
Primary Storage icon if you wish to change it from the default and type in a different 
size. Click Add on the Secondary Storage icon to add another storage device for a total 
of up to 10 storage devices.  

• Network Management Setting. Click View Settings Details to view the network 
details window.  

• IP Address. Manually map your public and private IPs.  

7. Click Save & Update to confirm your modifications. 

The top border of the Manage VM screen includes other options. Click the Available Actions link, and 
from the drop-down menu, you can choose: 

• Clone VM. The Clone VM feature is used to make an exact copy of a VM. 
• Console. The easiest way to access your VM is through the console link provided in the VM 

Listing. 
• Delete VM. This option will be used when you no longer need to use a VM and no longer need 

access to the data stored on the VM. 
• Export VM to Image Library. This allows you to create an image of an existing VM, enabling 

you to quickly create VMs from images with your specific software already installed. 

NOTE: You cannot decrease the amount of storage assigned to a VM, but you can 
increase the amount. 
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• Power Off. If you are no longer using a VM but wish to retain the device and all its data and 
settings for future use, use the Power Off function. This reduces the cost for that device when 
you do not need it but reserves it for quick implementation when you do. You will still be 
charged for the VM at a reduced rate while it is powered off. 

• Power On. When you are ready to begin using a powered off VM or Bare Metal Server again, 
you may perform the same steps as you did when you powered it off. 

• Reboot VM. Use this option to reboot the Virtual Machine. You can only reboot powered on 
VMs.  

MANAGE BARE METAL / DEDICATED FIREWALL 

If you need to make changes to an existing Bare Metal Server or Dedicated Firewall, you may use the 
Manage Bare Metal/Dedicated Firewall feature.  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing in the Combined Functions section.  
4. Locate the Device you wish to modify in the listing.  
5. Right-click the Bare Metal Server or Dedicated Firewall you wish to modify and click Manage 

Bare Metal / Dedicated Firewall in the menu.  

 
6. Make changes to any options needing changes:  

• Device Name  
• Description (optional)  

Service Plan 

To take a more in-depth look into your service plan, click Show Details. 

Bandwidth Usage 

From the drop-down menu, choose a time period:  
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• Hour  
• Day  
• Week  
• Month  
• Last Month  
• Year  
• Last Year  
• Custom  

Login Information 

• Login URL  
• Root Password  
• User Account  
• User Account Password  

The top border of the Manage My Device screen includes other options. Click the Available Actions link, 
and from the drop-down menu, you can choose:  

• Add/Modify Tag(s). Create new or search existing tags.  
• Assign to. Assign to a specific customer.  

POWER OFF/ON 

If you are no longer using a VM or Bare Metal Server but wish to retain the device and all its data and 
settings for future use, use the Power Off function. This action reduces the cost for that device when you 
do not need it but reserves it for quick implementation when you do. You will still be charged for the VM 
at a reduced rate while it is powered off.  

Alternatively, when you are ready to begin using a powered off VM or Bare Metal Server again, you may 
perform the same steps to power it back on.  

To power on/off a device:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing under the Combined Functions heading.  
4. Locate the Device you wish to power off in the listing.  
5. Right-click the Device you wish to power off and click Power Off or Power On in the menu, 

depending on the current state of the Device.  
6. Verify you want to power off/on the Device by clicking Power Off/On in the confirmation 

screen.  

NOTE: This action can be performed by clicking the Available Actions icon as well. 
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REBOOT A DEVICE 

Servers and VMs occasionally need to be rebooted, and it is probably a good idea for you to have a strategy 
for rebooting your VMs. Take into consideration your up-time and your business needs when developing 
that strategy.  

To reboot a device:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Device Listing under the Combined Functions heading.  
4. Locate the device you wish to reboot.  
5. Right-click the device and click Reboot in the menu.  
6. Verify by clicking Reboot. 

 

UPDATING VMWARE TOOLS 

It is necessary to keep VMWare Tools updated, but we are not able to automatically apply these updates 
for you. When an update is required, the VMWare Tools status on the VM Details screen will display as 
Outdated.  

 

 
Updating VMWare Tools is simple:  

1. On the Device Listing screen, right-click a VM.  
2. From the drop-down menu, choose Manage VM.  
3. Locate the VMWare Tools Missing or Outdated warning.  

 
4. Click the Missing or Outdated link.  
5. On the VMWare Tools screen, click Update.  

Monitor the progress of the update on the Provisioning Tasks screen.  

Once the update is completed, the VMWare Tools status will display the following status:  



©2021, phoenixNAP, LLC 

 

Page 25 of 124 

 

 

LOAD BALANCER POOLS 

A Load Balancer evenly distributes requests across Web servers commonly referred to as a "Server Farm" 
or a "Server Pool." When an HTTP request comes in, the Load Balancer looks at the load on each server 
before determining which server to send the request to. This ensures the availability of the server and 
protects against denial-of-service attacks. 

Methods of Load Balancing 

The Load Balancer currently uses the Round Robin and Least Connections methods of load balancing. 

• Round Robin mode passes each new connection request to the next server in line, eventually 
distributing connections evenly across an array of machines. 

• Least Connections passes a new connection to the pool member or node that has the least 
number of active connections. 

To access the Load Balancer screen: 

1. Sign in to the Client Portal. 
2. Open the Manage mega menu. 
3. Click Load Balancer under the Combined Functions section. 
4. Select one of your existing nodes to manage Pools. 

Use the Search field to filter your Load Balancer Pools.  

Create Pool 

1. Under the Pools tab, click the Create a Pool icon.  
2. Enter a Pool Name. Pool Name MUST start with a letter, followed by a letter, number, period, 

hyphen, or underscore.  
3. Enter a Port Number in the appropriate field. Here is a list of commonly used port numbers.  
4. Choose a Protocol type from the drop-down menu:  

• TCP. A network protocol used by many Internet applications, particularly Web pages.  
• SCTP. A network protocol that is a hybrid of sorts, performing functions in ways 

similar to TCP and UDP.  
• UDP. A network protocol that bypasses the traditional error checking of protocols 

based on the assumption that the service will be completed within the application 
doing the communicating. UD is commonly used for VoIP, streaming media, and for 
online games.  

NOTE: Load balanced bandwidth incurs an additional cost. 

http://en.wikipedia.org/wiki/Well-known_ports
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5. Choose a Balance Method. From the drop-down menu, choose Round Robin or Least 
Connections.  

6. Click the Add IP icon. You may add:  

• Private IPs of your bare metal servers or VMs by clicking Bare Metal Server or VM.  
• External IPs (not a VM). External IPs do not reside in your Cloud organization.  

Add as many IPs as necessary. You can delete an IP by clicking the trash can icon. 
7. Optionally, enable Health Checks for this pool.  
8. Click Save Pool. 

 

Edit Pool 

1. Select a Pool name to open its details.  
2. Click the Edit Pool link to make modifications.  

 
3. When you are finished making modifications, click Save Pool.  
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Delete Pool 

If you wish to delete a load balancer pool: 

1. Click the Delete Pool link in the row of the pool you wish to delete.  

  
2. Confirm your choice by clicking Delete this Pool. 

Health Checks 

To manage your health checks:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Load Balancer under the Combined Functions section.  
4. Click the Manage Health Checks tab.  

MANAGE HEALTH CHECKS 

Health Checks ensure that the Load Balancer distributes new requests only to servers that are operating 
and ready to receive them. Once a server exceeds the allowed number of health check failures, it is no 
longer considered eligible to receive new traffic requests. A health check can return values Healthy or 
Unhealthy. 

Create a Health Check 

To create a new Health Check:  

1. On the Load Balancer Pools page, click the Manage Health Checks tab.  
2. Select a Node.  
3. Click the Add Health Check button.  

 
4. From a drop-down menu, choose Type of Health Check:  

• HTTP. Required for HTTP and network load balancing.  
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• HTTPS. Recommended for backend services that require HTTPS.  
• TCP.  

5. Type in Monitor Name in the Field next to the Type drop-down menu. Monitor Name may 
not exceed 100 characters and must start with a letter followed by a letter, number, period, 
hyphen, or underscore. 

6. Depending on the Type of Health Check, fill out all or some of the following fields: 

• Interval. An approximate interval, expressed in seconds, between health checks of an 
individual instance. Default value: 5 seconds. 

• Up Interval (Default Value: Disabled). If Enabled, specifies the frequency in seconds 
at which the system issues the monitor check when the resource is up. 

• Time Until Up (Default Value: Zero Seconds). 
• Timeout. The amount of time, expressed in seconds, during which no response means 

a failed health check. Default value: 16 seconds. 
• Send String. Specifies the text string that the monitor sends to the target object. 

o Default value for HTTPS : GET /\r\n. 
o No default value for TCP.  

• Receive String (No Default Value). Specifies the regular expression representing the 
text string that the monitor looks for in the returned resource. The most common 
receive expressions contain a text string that is included in an HTML file on your site. 

• Receive Disable String (No Default Value). 
• Cipher List. Specifies the list of ciphers for this monitor. Default list: 

SHA:+3DES:+kEDH. 
• Username. Specify the username if the monitored target requires authentication. 
• Password. Specify the password if the monitored target requires authentication. 
• Compatibility (Default Value: Enabled). When enabled, specifies that the SSL options 

setting (in OpenSSL) is set to ALL. 

7. Click Save to finish the creation process. 

Edit a Health Check 

To edit a Health Check: 

1. On the Load Balancer Pools page, click the Manage Health Checks tab. 
2. Select a node to view the health checks associated with it. 
3. Select the Health Check you wish to modify and click it to open the details bar. 
4. Click Edit Monitor. 
5. Make the necessary modifications and click Save.  
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Delete a Health Check 

To delete a Health Check: 

1. Select a node to view a list of health checks associated with it. 
2. Click the Delete Check link in the row of the monitor you wish to delete. 
3. In the confirmation window, click Delete to confirm your choice. 

IP MANAGEMENT 

The IP Management screen can be used to view or locate: 

• Existing IP Addresses assigned to your Load Balancers and VMs. 
• Reserve new IP Addresses without assigning them to a Load Balancer or VM. 
• Release IP Addresses from Load Balancers and VMs. 
• View your IP Address use data.  

To access the screen:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
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3. Click the IP Management link in the Combined Functions section.  

 

Filter 

Use the built-in filter to find an IP. You can filter the results by:  

• Node. Filter by the Node to which an IP has been assigned to.  
• View. Filter by the type of Device to which an IP has been assigned to.  

o Cloud  
o Bare Metal Servers  
o Dedicated Firewalls  

Search 

Use the Search field to enter terms to search for within your IP Address collection. If you have filtered the 
results already, this search only searches within the filter results. There is no need for a "submit" or "go" 
button, the search begins when you type your first character. 



©2021, phoenixNAP, LLC 

 

Page 31 of 124 

 

List 

The list of IP addresses contains five data columns:  

• IP 
• Location. Data center location. 
• Cost. Device's service plan.  
• Name. The name of the device to which an IP has been assigned to 
• Available Actions. By clicking the Actions button in a drop-down menu, you will see the 

available actions.  

ASSIGN IP 

You can ONLY assign an IP to VMs that are Powered Off, and you may ONLY assign IP Addresses with a 
status of Reserved.  

To assign an IP:  

1. Click Actions in the Reserved IPs row that you wish to assign.  
2. Click Assign IP. 

 

3. Choose a powered-off VM to which the IP address will be assigned to.  
4. Click Assign IP.  

 

RELEASE IP 

You may ONLY release IP Addresses with a status of Reserved. If for any reason you no longer need a 
reserved IP Address:  
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1. Click Actions in the Reserved IPs row that you wish to release.  
2. Click Release IP.  
3. Click Yes to confirm your actions.  

VIEW/MODIFY IP 

This action is available ONLY for Non-Reserved IPs. To view or modify an IP:  

• Click Actions in the Non-Reserved IP's row that you wish to view/modify.  
• Click View/Modify IP.  

 
The IP Mapping window opens. Here you may view/modify:  

o Public Pool  
o My Reserved Pool  
o Public IPs. Filter your view by typing an IP in the Filter field.  

• Drag/Drop IPs between Pools. You can add IPs from the Public Pool or My Reserved Pool 
section to the Public IPs. First, click Add Public IP and then drag the New IP icon (with the blue 
hash marks in the lower right corner) to the Drag/Drop any IP here area.  

• In the Private IPs column, click Edit and type the Private IP Address you wish the public IPs to 
map to. 

 
• You can additionally select several IPs to bring over from the public pool. Selecting the number 

in the drop-down menu and click Add. 
• You may also type in a reserved IP in the Type Reserved IP field, and add it by clicking Move. 
• Create a new mapping by clicking the Add New Mapping button.  

Always click Save to save your changes. 

NOTE: You cannot add a Reserved IP to your Public Pool while modifying your VM, and vice 
versa. Use the IP Management Screen to add/remove IPs to/from the Reserved Pool. 
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Any changes to the mappings are submitted to the queue and can be viewed on the Provisioning Tasks 
screen. 

 

 

 

 

 

ADD/RESERVE NEW IP 

To create a new IP Address and reserve it for your organization:  

1. Click the Add/Reserve New IP icon in the upper-left corner of the screen.  
2. Choose a device for which you are adding or reserving a new IP: 

 

• Cloud. Choose a node and view the pricing for a reserved IP. Click Add IP to agree and 
create a public IP address.  

• Bare Metal Servers. To add an IP, you need to submit an IP justification form. Provide 
the necessary information and submit the form by email to 
ipmanagement@phoenixnap.com. You may request additional IP space only if you 
are using at least 80% of the current IPs. 

• Dedicated Firewall. To add an IP, you need to submit an IP justification form. Provide 
the necessary information and submit the form by email to 
ipmanagement@phoenixnap.com. You may request additional IP space only if you 
are using at least 80% of the current IPs.  

REQUEST ADDITIONAL IPS 

This is the process of acquiring additional IPs for your Bare Metal Servers or Dedicated Firewalls.  

To request an IP:  

1. Click Actions in the row of a Reserved Bare Metal IP.  
2. Click Request Additional IPs.  
3. Click Open PDF. This is the IP justification form.  

IP Mapping 

IP Mapping influence firewall and load balancing rules that have been set up.  

• Firewall rules will automatically begin tracking new Private IPs for the destination VM in any 
previously set up rules for the VM.  

• Load Balancers allow you to select a VM or a Public IP for load balancing needs.  

 

https://help.phoenixnap.com/display113
mailto:ipmanagement@phoenixnap.com
https://help.phoenixnap.com/display113
mailto:ipmanagement@phoenixnap.com
https://help.phoenixnap.com/display113
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4. Fill in the blank fields and submit the form by email to ipmanagement@phoenixnap.com 
(preferred method). If you prefer to fax the form in, use 480 449 8801. This method may delay 
the processing of your request.  

PROVISIONING TASKS 

The Provisioning Tasks screen allows you to see the status of in-progress processes. A Process can be any 
function initiated in the admin, such as rebooting or renaming a VM, to creating a VM from scratch or 
deploying a Bare Metal Server.  

This screen shows items that take more than a few seconds to complete. A status bar will show you the 
current status of your actions, as in the image below.  

 

To access the screen:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Provisioning Tasks under the Combined Functions heading.  

NOTE: You may request additional IP Space only if you are currently using at least 80% of the current IPs. 

mailto:ipmanagement@phoenixnap.com
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If you see the message "No data available in table", then you have no processes in progress.  

If you wish to clear completed processes from the list, click the Clear All Completed link at the top-right 
section of the screen.  

 

The following columns are available in this report:  

• Process Timestamp. The time the process was initiated.  
• Requested Process. The process currently being worked on.  
• Current Task & Status. The task that is currently being carried out. This may or may not be 

the same as the Requested Process. For example, if the Requested Process is Deploy New 
Server, the Current Task could be Order Processing, Deploy Server, Configure Server, or any 
other task that applies. A status bar will indicate the status of the process.  

• Action. If an action can be taken on a process in the list, it will be listed in this column. 
Examples include Stop Process, Try Again, and Clear from List.  

If you have multiple processes in progress, you can sort them by using the Up and Down arrows at the 
top of the columns.  
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NEW FUNCTIONALITY NOTICES 

New node functionality items available for your use will be displayed on the New Functionality Notices 
screen. The Help link provides more information.  

To reach the New Functionality Notices screen:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click New Functionality Notices under the Combined Functions section.  

Be sure to check for new notices regularly. 

Available Actions 

Under the Action column, you will find available actions for a specific notice.  

• Manage. This link offers options in configuring the new functionality (may differ for each 
functionality).  

• Remove Notice. Remove the row from appearing in the table.  
• Help. Provides more information on the notice.  

TAGS 

Tags are used to sort your devices into manageable categories and containers. They have no effect on 
how your devices run or how they are billed, they simply make it easier to filter and manage your devices.  

To reach this tool:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Tags in the Combined Functions section.  

On the Tags screen, you can browse through existing tags. Click a tag to see the list of devices assigned to 
that tag.  

Available Actions 

Add a new tag by clicking this icon and entering a tag name in the field. When 
finished, click the Plus sign to create a tag.  

You may Delete or Rename a tag by clicking the Preference icon next to an existing tag's name. 
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UNIFIED NETWORK 

The phoenixNAP Unified Network enables you to achieve connectivity between your dedicated servers or 
Colocation environment and your PNAP virtual assets.  

To unify your back-end network, you need to submit a ticket. Include your Account Name with the 
request.  

To reach the Unified Network screen:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Unified Network under the Combined Functions heading.  
4. Click Submit Ticket to proceed. 

 

 
 

FORWARD / REVERSE DOMAIN NAME SYSTEM (DNS) 

What is the difference?  

When supplied with a domain name (for example, google.com), a forward DNS lookup will return the IP 
address for the provided domain. When you access Google, a DNS server looks in its forward lookup zone 
for the site's IP address(es). Then, the server returns them to you. This type of record is called an A record 
and is the most common one. A forward DNS lookup can contain other records, such as MX, C-Name, etc. 

A reverse DNS lookup is used to find the domain name for a supplied IP address. You normally supply the 
IP address backward and append .in-addr.arpa (more info at http://en.wikipedia.org/wiki/.arpa). This 
feature is useful to anyone, but it is especially practical for those running an outgoing mail server.  

A good tool for finding rDNS or normal DNS records is dig. 

How to reach the DNS screen? 

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Forward DNS / Reverse DNS under the Combined Functions heading.  

https://toolbox.googleapps.com/apps/dig/
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How to add a domain name? 

 

1. Open the Forward DNS Records or Reverse DNS Records screen.  
2. Click Add Domain Name/s.  
3. Copy/paste or manually enter domain name/s (use a comma to separate multiple entries).  
4. Click Add when you finish adding domain names. Identical domain entries will be ignored. 

 
 

 

NOTE: All Domain Name Ownership must be verified! The names may not be published until this is 
completed. Find more information on this topic in the Domain Verification section of the help guide. 
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List 

The Domain Name Listing offers the following information:  

1. Verified Status. This will show you if the domain has been verified or not.  

1. Not Verified. The Verification process has not begun yet. Please begin the verification 
process by choosing Actions > Verify.  

 
A verification email will be sent to the domain owner. Alternatively, complete the 
process via DNS String. Update your TXT record with the string provided. Once 
complete, click the Actions > Verify link to complete the process. Click Yes, I updated 
my Registrar.  

2. Warning. This occurs after a domain has been verified for ownership, and the system 
starts checking for NS entries at their registrar. If this fails, a warning status will 
appear. Update your NS entries to point to phoenixNAP's name servers. Once 
completed, click the Actions > Resolve link to complete the NS related entry process. 
Click Yes, I updated my Registrar.  

3. Verified. The Verification process has been completed successfully, and the NS 
records at your registrar have been updated to point to our name serves.  

2. Domain Name.  
3. Added On. Date of adding the domain.  
4. Manage. Click the Actions icon to open the menu with the following options:  

• Modify. ONLY non-verified domain names can be modified. You can modify a domain 
name as desired. After modifying the name, click Update to confirm your changes. Be 
aware that modified domain names must go through the entire verification process.  

• Resolve. Update your NS entries to point to phoenixNAP's name servers. Once 
completed, click the Actions > Resolve link to complete the NS related entry process. 
Click Yes, I updated my Registrar.  

• Delete. Deletes a domain name as well as any forward DNS / reverse DNS records 
associated with it.  

• Verify. You can reset the verification process ONLY if domain ownership has not been 
verified yet.  

Verified Status, Domain Name, and Added On columns are sortable. 
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Mappings 

1. Forward DNS Mappings 
2. Reverse DNS Mappings 

DOMAIN VERIFICATION 

Any time you add a new domain name, you must verify it. An email will be sent to the domain admin to 
verify ownership. Identical domain names will not be added!  

You will receive a verification notice for your domains:  

1. Not Verified. The Verification process has not begun yet. Please begin the verification 
process by choosing Actions > Verify.  

 
A verification email will be sent to the domain owner. Alternatively, complete the 
process via DNS String. Update your TXT record with the string provided. Once 
complete, click the Actions > Verify link to complete the process. Click Yes, I updated 
my Registrar.  

2. Warning. This occurs after a domain has been verified for ownership, and the system 
starts checking for NS entries at their registrar. If this fails, a warning status will 
appear. Update your NS entries to point to phoenixNAP's name servers. Once 
completed, click the Actions > Resolve link to complete the NS related entry process. 
Click Yes, I updated my Registrar.  

3. Verified. The Verification process has been completed successfully, and the NS 
records at your registrar have been updated to point to our name serves.  

 

 

Warning! Please be aware that DNS can be a confusing and complicated system. If you get something 
wrong, you might experience problems such as bouncing emails sent to your domain, or even cause your 
domain's website to malfunction. We recommend you use the DNS manager with caution, and ONLY if you 
understand basic concepts in the DNS management. 
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Domain Verification is a two-step procedure:  

1. Verify domain ownership, either via Email or via DNS String. Begin the verification process by 
selecting Actions > Verify.  

2. Configure your Name Server (NS) Records to point to our phoenixNAP servers. 

• ns1.phoenixnap.com  
• ns2.phoenixnap.com  

Verifying Ownership via Email 

An email will be sent to you with a link to verify the domain. Simply click the link and follow the 
instructions.  

If you didn't get the email, click the Resend the Email link on the Verify Domain Name (via Email) window, 
or opt for the Alternative Method (via DNS String).  

Verifying Ownership via DNS String 

If you didn't receive an email:  

1. Select Actions > Verify again.  
2. Select Alternative Method.  
3. Click Generate Verification String. You must verify the domain by entering a unique string as 

a TXT record with your registrar. You must use the string that we provide.  
4. Copy the string.  
5. Go to your domain name's registered registrar.  
6. Enter the string as a TXT record.  
7. Once you have updated your registrar, return to the phoenixNAP Client Portal, and select 

Actions > Verify again. This time, select the Yes, I updated my Registrar link that indicates 
you completed this task.  
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Updating Your NS Records 

Once domain ownership is verified, either via email or string, you must continue to the next step and 
update your NS records at your registrar to point to the NS servers that are presented to you.  

1. Go to your domain name's registered registrar.  
2. Create two NS records: 

• ns1.phoenixnap.com  
• ns2.phoenixnap.com  

3. Once you have updated your registrar, return to the phoenixNAP Client Portal and select 
Actions > Verify again. Select the Yes, I updated my Registrar link that indicates you 
completed this task.  

You should receive a confirmation message stating that the NS Record has been verified. You can publish 
your domain.  

If you are experiencing any difficulties, please contact Support, which is at your disposal 24/7. 

 

NOTE: This alternative option is always available to use if you prefer, even if an email was sent to you. 
If there is an error in the verification process, you will be notified. 

NOTE: Keep in mind that it can take up to 24h for the DNS manager to process domain verification. 
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FORWARD DNS MAPPINGS 

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Forward DNS / Reverse DNS under the Combined Functions heading.  
4. Click the Forward DNS Records tab.  

 

 

 

Available Actions 

There are three (3) available actions:  

1. Add Forward DNS. Click Add Forward DNS, located above the list to add a new forward DNS 
record. A popup menu will open:  

• Select a domain from your domain list.  
• Select DNS Record Type. For further information about DNS Record types, follow this 

link.  
• Enter DNS Record Details:  

o Name. You manually enter a name you want.  
o Record type-specific options. Different types of DNS Records will provide 

various record-specific options. See the Supported Forward DNS Record 
Types and Their Respective Record Values section below.  

o DNS Time to Live Value. Enter a value in the appropriate field and select a 
time unit from the drop-down menu.  

Under the Manage column, you will find two links: 

1. Actions.  

• Delete. Deleting a DNS record will delete all associated Forward DNS records.  
• Modify. Click this link to modify an existing Forward DNS record.  

2. More Details. Open the More Details link in order to get a list of all the external details that 
are not listed in the table.  

SUPPORTED FORWARD DNS RECORD TYPES AND THEIR RESPECTIVE RECORD VALUES 

You can add eight (8) different types of DNS records:  

1. A/AAAA Address (Host) Record. These records specify the IP address (IPv4 or IPv6) for a given 
host and point to that IP address. Useful if you have subdomains residing on various systems.  

Forward DNS Records List 
By default the Forward DNS Records list will show all records. Use the Search field to narrow down the 
result. Know that Verified Status, Domain, and Record Type columns are sortable. 

http://www.debianhelp.co.uk/dnsrecords.htm
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• Name. A record name is composed of a series of parts called labels delimited with 
dots '.'. Each label can contain up to 63 characters. The entire record name must not 
exceed 253 ASCII character length.  

• IP Address (v4/v6) or Add IP. Enter an IP address of the FQDN. A valid IP address 
consists of a four-octet 32-bit address. Use a comma to separate multiple entries. If 
you choose the Add IP option, specify Node, Device, and IP.  

• Select Pointer (PTR) Record Creation.  

1. Create PTR Records. PTR Records are created if there are no existing records 
associated with the IP Addresses added.  

2. Always Create PTR Records. PTR Records are created regardless of existing 
records associated with the IP Addresses added.  

3. Do Not Create PTR Records.  

• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 
seconds.  

Example Domain: domain.com 

Sample Format: IN A 69.9.64.11 

Where: 
1. IN indicates Internet 

2. A indicates record type 

3. 69.9.64.11 indicates the IP address of domain.com 

2. CNAME (Canonical Name Record). Use to make domains and subdomains an alias of another 
domain. It ties a host name to an A record. With a CNAME record, instead of making several 
A records, you can create one record and point them to one A record. The advantage of this 
approach is that when you need to change an IP address, all you need to do is change the A 
record's IP address. 

• Name. A record name is composed of a series of parts called labels delimited with 
dots '.'. Each label can contain up to 63 characters (a-z, A-Z, 0-9, and hyphens '-'). 
Labels may not start or end with a hyphen. The entire record name must not exceed 
253 ASCII character length.  

• Alias. Enter a domain to be tied to an A record.  
• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 

seconds. 

Example Domain: mail.something.com 

Sample Format: IN CNAME mail.something.net 

Where: 
1. IN indicates Internet 

2. CNAME indicates record type 

https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
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3. MX (Mail Exchanger Record). Use to specify which mail servers should emails be routed to. 
The MX DNS record needs a priority value as a part of its entry - it sets the priority of a target 
host.  

• Name. The Record Name must be composed of a series of parts called labels delimited 
with dots '.'. Each label can contain up to 63 characters. The entire record name must 
not exceed 253 ASCII character length.  

• Mail Exchange Server. Enter the mail server name.  
• Priority. Enter a numerical value between 0 and 65535, indicating the priority level 

assigned to a server. Lower value means that a server is more preferred.  
• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 

seconds.  

Example Domain: thisdomain.com 

Sample Format: thisdomain.com. 14400 IN MX 0 thisdomain.com. 

 

1. This record shows that all mail @thisdomain.com should be routed to the 
mail server at thisdomain.com. 

2. The number zero (0) indicates the priority level. 

3. Make sure that there is a dot at the end of the domain name in the MX 
record. If there is no dot, emails are routed to thisdomain.com.thisdomain.com. 

4. TXT (Text Record). Use to insert any text-based information that can be called upon when 
necessary. Usually, TXT is used to verify domain ownership and to implement SPF.  

• Name. The entire record name must not exceed 253 ASCII character length.  
• Text. A text-string which is to be passed in to the TXT record. Enter up to 4,000 

characters. Apostrophes and dollar symbols "$" are not allowed.  
• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 

seconds.  

Example Domain: example.com 

Sample Format: example.com. TXT @ "Random text" 

Where: 

1. TXT indicates record type 

2. @ indicates record name. (In this case, it is blank, which is indicated by 
@.) 

3. "Random text" indicates the arbitrary text entered in the record. 

 

5. LOC (Location Record). Use the LOC record to specify geographical location information of a 
domain.  

https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
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• Name. A Record Name must be composed of a series of parts called labels delimited 
with dots '.'. Each label can contain up to 63 Characters. The entire record name must 
not exceed 253 ASCII character length.  

• Geographic Location Text. Specify a geographical location.  
• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 

seconds.  

Example Domain: mydomain.com 

Sample Format: mydomain.com. LOC 52 14 05 N 00 08 50 E 10m 

Where: 
1. LOC indicates record type 

2. 52 14 05 N 00 08 50 E 10m indicates the geographical location. 

 
 
 

6. NS (Name Server Record). Use to specify an authoritative name server for a given host.  
• Name. The Record Name must be composed of a series of parts called labels delimited 

with dots '.'. Each label can contain up to 63 characters. The entire record name must 
not exceed 253 ASCII character length.  

• Name Server. The Name Server is composed of a series of parts called labels delimited 
with dots '.'. Each label can contain up to 63 characters. The entire value must not 
exceed 253 ASCII character length. Empty spacing and asterisks "*" are not allowed.  

• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 
seconds.  

Example Domain: example.com 

Sample Format: example.com. IN NS ns1.phoenixnap.com. 

Where: 

1. IN indicates Internet 

2. NS indicates record type 

3. ns1.phoenixnap.com. is the authoritative server for the domain 
example.com 

7. SPF (Sender Policy Framework Record). The SPF record values specify which servers are 
allowed to use your domain name to send emails legitimately. This serves as an email-
validation record system designed to detect email spoofing. 

• Name. A Record Name must be composed of a series of parts called labels delimited 
with dots '.'. Each label can contain up to 63 characters. The entire record name must 
not exceed 253 ASCII character length.  

• Rule. Enter up to 4,000 characters. Apostrophes (") are not allowed (e.g., v=spf1 -all).  

https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
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• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 
seconds.  

Example Domain: example.com 

#1 Sample Format: mydomain.com. TXT "v=spf1 -all" 

Clarification: This is the simplest possible SPF record. It means the domain example.com 
never sends mail. This makes sense to have if a domain never sends emails. 

#2 Sample Format: TXT "v=spf1 mx -all" 

Clarification: Designate MX servers, as they do send mail. 

#3 Sample Format: mydomain.com. TXT "v=spf1 mx ptr -all" 

Clarification: This designates all the hosts whose PTR hostname matches example.com 

8. SRV (Service Locator Record). Use this to provide information on available services. For 
example, given a known domain name, you can define the port and hostname for a given 
service.  

• Name. A Record Name must be composed of a series of parts called labels delimited 
with dots '.'. Each label can contain up to 63 characters. The entire record name must 
not exceed 253 ASCII character length.  

• Host Name. The system which receives the service. This Host Name is composed of a 
series of parts called labels delimited with dots '.'. Each label can contain up to 63 
Characters. ‘*’ and empty spacing between characters are forbidden. The entire value 
must not exceed 253 ASCII character length.  

• Priority. A numerical value between 0 and 65535, indicating the priority level assigned 
to the host. Lower values give higher priority (zero (0) gives the highest priority).  

• Weight. A numerical value between 0 and 1410065407 used as a load balancing 
mechanism.  

• Port. Enter a numerical value between 0 and 65535. This is the actual port number of 
the service in the offer.  

• TTL. The DNS Time to Live must be greater than 0 and must not exceed 2,147,483,647 
seconds.  

Example Domain: somedomain.com 

Sample Format: _service._proto.name. TTL class SRV priority weight port target. 

Where: 

1. "service" is the symbolic name of the desired service 

2. "proto" is the transport protocol of the desired service. This is usually TCP 
or HTTP. 

3. "name" is the domain for which this service is valid. (Ending with a dot.) 

https://en.wikipedia.org/wiki/ASCII#ASCII_printable_characters
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4."TTL" is time to live 

5. "class" is always IN 

6. "priority" indicates the priority level of the target host. Lower value equals 
greater importance. 
7. "weight" is used when more than one service has the same priority. A 
higher value gives greater importance. 

8. "port" is the port number of the service in question. 

9. "target" is the name of the host that provides this service. Does not have 
to be in the same zone (domain). 

DNS record value specifies where you want to point your record, or in some cases, what you want to do 
with it. These values vary in type, depending on the DNS record type. 

Time to Live Value (TTL) 

For the TTL, enter a numerical value of how long a DNS record will be cached before it needs to be 
refreshed. The default value for TTL is 3600 seconds, but you can enter any value greater than zero (0) 
and specify it in seconds, minutes, hours, or days. Any changes you make to the value of a DNS record 
occurs in the specified time to live period. (e.g., If you make a change to a DNS record and the TTL is set 
to 600 seconds, it will take that time until the new information takes effect.)  

REVERSE DNS MAPPINGS 

Reverse DNS is a technique in which an IP address is resolved into a domain name.  

To reach the Reverse DNS Mappings screen:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Forward DNS / Reverse DNS under the Combined Functions heading.  
4. Click the Reverse DNS Records tab. 

 

Same as Zone 
Uncheck 'Same as Zone' if name differs from My Domain. If same as zone, "@" will indicate record 
name. 
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Record Type 

A PTR record is used to perform reverse DNS lookups. A PTR record, or pointer record, maps an IPv4/v6 
address to the canonical name for that host. Setting up a PTR record for a hostname in the in-addr.arpa 
domain that corresponds to an IP address implements reverse DNS lookup for that address.  
 
For example, www.random-site.com has the IP address 122.0.3.16, but a PTR record maps 16.3.0.122.in-
addr.arpa. It is always advisable to have a proper reverse DNS record (PTR) set up for your servers, 
especially when you are running a mail / smtp server.  

Creating PTR Records 

Whenever you add an A/AAAA Address (Host) Forward DNS Record, you can create PTR Records.  

1. Select a domain.  
2. Choose an A/AAAA Address (Host) record.  
3. Enter or add IP addresses. Use a comma to separate multiple entries.  
4. Select Pointer (PTR) Record Creation.  

• Create PTR Records. (ONLY if there are no PTR records associated with to the IP 
address(es) added.)  

• Always Create PTR Records. PTR Records are created regardless of existing records 
associated with the IP addresses added.  

• Do not Create PTR Records. PTR records will not be created, and you will not have 
rDNS mappings associated with the IP address(es) added.  

When you decide to create PTR records, they will be made available on the Reverse DNS page.  

Available Actions 

The phoenixNAP Client Portal enables you to modify or delete an existing rDNS record.  

To modify a rDNS record:  

1. Open the Forward DNS / Reverse DNS screen.  
2. Click Reverse DNS Records.  

Reverse DNS Records List 
By default, the Reverse DNS Records list will show all records. Use the Search field to narrow down 
the result. The Verified Status, Domain , and IP Address columns are sortable. 
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3. Click Actions > Modify under the Manage column. Pay attention to the main three (3) pieces 
of information:  

• DNS Record Type. This displays "PTR Pointer Record." 
• IP Address (v4/v6). The IP address(es) associated with the A/AAAA record.  
• A/AAAA Address (Host) Record. This displays the A/AAAA Address (Host) Record to 

which the IP address(es) maps to. Open the menu to select another A/AAAA Address 
(Host) Record.  

To delete an rDNS record:  

1. Open the Forward DNS / Reverse DNS screen.  
2. Click Reverse DNS Records.  
3. Click Actions > Delete in the row of the PTR record you want to delete.  
4. Click Delete to confirm your choice.  

 

BARE METAL 

In the Bare Metal section of the Manage mega menu, you will find all the tools necessary to deploy Bare 
Metal Servers and put up Dedicated Firewalls. 

DEPLOY NEW SERVER 

On the Deploy New Server screen, you can purchase bare metal servers. Our order form allows you to 
view the pricing and order multiple products from the same category at the same time. 

NOTE: Please be aware that you can select only those A/AAAA Address (Host) Records that share the 
same IP Address. 

NOTE: The prices on the form are per month. A contract is not required. However, if you want a 
contracted price, you may be eligible for a discount depending on the quantity and the contract length. 
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 To order a Bare Metal server: 

1. Log in to the Client Portal.  
2. Navigate to the Manage mega menu. 
3. Select Deploy New Server to load the order form screen.  

 

 

4. Select a data center location from the drop-down menu. The available products load in the 
section below.  

5. Choose a product you want to purchase and select ORDER. Currently, you can order one type of 
product at the same time.  

NOTE: 

You can also launch the order screen from the:  

• Dashboard landing page. If you do not have an existing device, 
you can select Create a Bare Metal Server. 

• My Custom / Contract Pricing page. Select “Shop for Server.” 

 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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6. Select the desired Configuration Options choose the Quantity (up to 100).  

 

Add special instructions or requests if you have any. Select Next when you are ready. The 
displayed monthly estimated total price is without Tax/VAT at this point.  

7. Review the details and select Next at the Account Details screen. The form pulls the information 
you entered when you created the Client Portal account.  
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8. Read the Master Service Agreement and Acceptable Use Policy. Tick the checkboxes when you 
have read and agree with the terms and select Next to proceed. You need to tick both boxes to 
continue to the Payment Options section.  

 

9. Choose a Payment Method and select Pay after you review the order information. The Grand 
Total includes Tax/VAT based on your business location. Fill in the payment information to place 
your order.  

• Optionally, you can select Export to Excel to save the order details in a Microsoft Excel 
file.  

• At this point, you cannot edit the order details. Select Restart My Order if you want to 
reset the form and start from the beginning.  
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10. Once the order is processed, you will be redirected to the Client Portal confirmation page. You 
can check the order status by clicking the View Deployment button.  
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If your payment cannot be processed for any reason, you will be redirected to the following 
screen: 

 

For any questions about your order, please contact Sales.  

 

DEDICATED FIREWALLS 

The Dedicated Firewall screen allows you to manage your dedicated firewall devices.  

To reach the Dedicated Firewall page:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Dedicated Firewall under the Bare Metal heading.  

The page loads the Device Listing screen with the Dedicated Firewall checkbox preselected.  

Display 

You can change the view by clicking the Display icon. 

 

Filter 

You may filter out your dedicated firewall devices by Node. Choose one of your nodes to view the 
dedicated firewall devices assigned to it.  

 

Dedicated Firewalls 
The purchase method for dedicated firewalls is completely the same. On the Deploy New Server 
screen, choose a dedicated firewall and build your order. 

mailto:sales@phoenixnap.com
https://help.phoenixnap.com/Login
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Available Actions 

To access many of these functions, right -click a device. Alternatively, there may be buttons or links, such 
as the Available Actions button, that will take you to some of these functions from the Device Listing 
screen as well.  

 

• Add/Modify Tag(s). Create new or search existing tags.  
• Assign to. You can assign a BM firewall to a specific customer if you have this option.  
• Manage Dedicated Firewall. This will take you to the Manage My Device screen, where you 

can see more in-depth information about the dedicated firewall:  
o Device Name. You can change Device Name by clicking Edit. Enter a new name in the 

field and click Save.  
o Description. Change the description by clicking Edit. Enter a description in the field 

and click Save.  
o Location. The node to which the dedicated firewall is assigned to.  
o Assigned IP Addresses  
o Login Information  
o Service Plan  
o Tags  
o Bandwidth Usage. Choose a time period (Hour, Day, Week, Month, Last Month, Year, 

Last Year, or create a Custom time period) and click Update.  

PUBLIC CLOUD 

The Public Cloud navigation area provides you with functionality that allows you to set up, monitor, and 
maintain your virtual assets.  
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DEPLOY NEW VIRTUAL MACHINE (VM) 

To create a Virtual Machine:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Deploy New VM under the Public Cloud section. The Create a Virtual Machine (VM) 

page loads.  
4. Make any necessary changes:  

• Choose a Model. Create from scratch, use an existing configuration, or import an 
image from the Image Library.  

• Select a Node. Node to which the VM will be assigned to.  
• Name of VM. No spacing, no special characters ("-" and ".") are allowed.  
• Description (optional). Enter a description for your VM in the text box, if desired. This 

can help you identify the VM and the components. If you have or plan on making a 
great deal of VMs, we recommend you add a description.  

• Tags (optional). If you wish to assign an already existing tag to the new VM, choose 
that tag name from the drop-down menu. If you wish to create a new tag to assign to 
the VM, enter a tag name and click the plus sign.  

• OS & Version. Choose the OS and its version to be installed on the VM. This cannot 
be changed later. 
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• Make this many VMs. From the drop-down menu, choose anywhere between one 
and five. If you create more than one VM, the VM name will be followed by a 
timestamp. 

• VM Administrator Username and Password. The VM username and password you 
enter is not recoverable once the VM is established. You need the credentials to 
modify the VM in the future. We recommend you store the credentials safely for 
future reference.  

• # VCPUs. Select how many Virtual Central Processing Units (VCPUs) to assign to the 
Virtual Machine. You may either move the slider or enter a number in the box. The 
slider/box will not let you select an amount that exceeds the allocations assigned to 
you.  

• Memory (RAM). Select how many gigabytes of RAM to add to the VM. Either move 
the slider to select or enter a number in the box on the right side. The slider/box will 
not let you select an amount that exceeds the allocations assigned to you.  

• Storage. Primary Storage and Secondary Storage icon is displayed. Click Edit on the 
Primary Storage icon if you wish to change it from the default and type in a different 
size. Click Add on the Secondary Storage icon to add another storage device for a total 
of up to 10 storage devices.  

• Network Management Setting. Displays the current network management status for 
the VM and allows you to view the details. Network management settings can be 
updated in the Network Settings area.  

• Private IP Addresses. You will automatically be assigned a private IP address.  
• Public IP Addresses. Use the drop-down menus to indicate your preference for having 

the VM externally accessible, and how many public IPs you wish to use. 

Minimum System Requirements 

It is your responsibility to know the Minimum Requirements for the Operating System you intend 
to use. At this time the hardware sliders are not sensitive to the operating system that you 
choose and will allow you to configure VMs that are below or far beyond the minimum and/or 
maximum requirements for the Operating System and/or the software you intend to run on the 
VM. Optionally, visit these third party sites for information on minimum system requirements 

   

https://help.phoenixnap.com/Minimum+System+Requirements+for+Operating+Systems
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• Power Status. Click it to change the status. Toggle Yes if you wish to have the VM 
operational immediately upon creation.  

• Optionally, enable the 'Create VM' Notification Email option.  
• You can save the VM settings for future use as a configuration by clicking the Save 

these settings... checkbox and entering a configuration title in the field.  
• Click the "My account agrees to add this Virtual Machine to my account and will be 

billed..." checkbox.  

Click Create Virtual Machine/s to deploy a new VM.  

 

In the pop-up window, click Continue: Create the VM to confirm your choice.  

You can monitor the progress on the Provisioning Tasks screen. 

VM IMAGE LIBRARY 

The Image Library screen provides a listing of your existing images and allows you to perform image-
related tasks:  

 

Additional Public IP Addresses 
To obtain additional Public IP Addresses or to add a previously leased IP that you saved for later 
use: 

1. Click View/Add Public IPs, then select one of the following:  

 
• Get new IPs assigned. Select this option if you do not have an existing 

leased IP but wish to lease an IP and assign it to the VM.  
• Use the IPs selected below. Select this option and then choose an 

i i  l d IP if  i h   h  IP i   
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• Upload Image. Upload a new file from an external source into the image library.  
• Create VM From Image. Use an existing VM Image to create a new VM.  
• Copy Image to Another Node. Allows you to copy an image and place it in a different node.  
• Download Image. Download and transfer an existing image to an external source.  
• Delete Image. Delete an existing image from the image library.  

Images are created from the Deploy New VM screen.  

To access the Image Library:  

• Sign in to the Client Portal.  
• Open the Manage mega menu.  
• Click VM Image Library under the Public Cloud section.  

When populated, the Image Library looks like this:  

 

The above-mentioned tasks are initiated by clicking one of the buttons at the bottom of the screen, but 
the list itself provides the following functions:  

• Filter by Node. Select a node from the drop-down menu to view the images that reside on a 
particular node.  

• Sort. Click the up/down arrows at the top right of the column to sort by that column; click 
once for alphabetical, twice for the reverse-alphabetical order.  

• Info. Click the blue question mark icon in the Info column to see and edit details about an 
image:  

 

Click Update when to save your changes.  
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UPLOAD IMAGE 

To upload an image:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Image Library under the Public Cloud section.  
4. Click the Upload Image icon.  
5. Select a Node to place this image in and click Continue.  

 
6. The Image Upload screen loads: 

 
7. Select the file type you want to upload.  
8. Click Browse and choose the file you want to upload from your machine.  

https://help.phoenixnap.com/Login
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9. Fill in the fields and choose an OS from the drop-down menu.  
10. Click Start the Upload.  

CREATE VM FROM IMAGE 

Use an existing VM image to create a new VM.  

To do so:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Image Library under the Public Cloud section.  
4. Click an image to highlight it and click Create VM from Image.  
5. On the Create a Virtual Machine (VM) screen, make any changes necessary to the virtual 

hardware and settings for the VM.  
6. Make sure to select the "My account agrees to add this Virtual Machine to my account and 

will be billed...", then click Create Virtual Machine/s.  

COPY IMAGE TO ANOTHER NODE 

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Image Library under the Public Cloud section.  
4. Click to select the image you wish to copy.  
5. Click Copy Image to another node.  
6. From a drop-down menu, choose the node to paste the image to.  
7. Click Complete Copy Process.  

DOWNLOAD IMAGE 

To download an Image:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Image Library under the Public Cloud section.  
4. Select a VM image you wish to download by clicking it.  
5. On the VM Image Library screen, click the Download Image icon.  

DELETE IMAGE 

To delete an Image:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  

NOTE: The Node, OS & Version, and Storage are not editable. All other settings can be adjusted. 
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3. Click VM Image Library under the Public Cloud section.  
4. Select a VM image you wish to delete by clicking it.  
5. On the VM image Library screen click the Delete Image icon.  
6. Confirm your actions by clicking Yes, Delete, or discard this attempt by clicking Cancel.  

Check for progress on the Provisioning Tasks screen.  

VM CONFIGURATIONS 

A VM Configuration is data about a VM setup that you have saved for future use. Configurations make it 
easy to create VMs on the fly with the same configurations as other VMs in your organization. 

To access the VM Configurations List:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Choose VM Configurations under the Public Cloud heading.  

You are provided with a list of configurations you have previously saved, if any. You can also 
create configurations during the Deploy a New VM process. 

4. Click the name of a Configuration in the list to view details about it.  

The following functions can be performed from this screen:  

• Edit Configuration by clicking the Edit icon at the right side of the screen.  
• Delete Configuration by clicking the Delete icon at right side of the screen.  
• Create New Configuration by using the Create New icon at the top-left side of the screen.  

 

NOTE: There is no charge for stored configurations. A configuration simply stores the settings for a VM, 
        

https://help.phoenixnap.com/Login
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EDIT VM CONFIGURATIONS 

You may make changes to the saved configurations from the edit screen.  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Configurations in the Public Cloud section.  
4. Click the name of a Configuration you wish to modify.  
5. Click the Edit icon.  
6. Make changes to any of the following fields:  

• Name. No spaces and/or special characters are allowed in the configuration name.  
• Power Status. Use the slider to choose On if you wish VM to be powered on 

immediately, or Off if you are creating the VM for later use and do not need it to be 
powered on right away.  

• OS & Version. Select the operating system you want to have installed on the VM in 
the first drop-down menu, then select which version of that operating system to 
install. Available operating systems are:  

o CentOS 64 bit  
o CentOS cPanel Sofaculous 64 bit  
o Microsoft Windows Server 2008  
o Microsoft Windows Server 2008 Plesk  
o Microsoft Windows Server 2012  
o Red Hat EL 64 bit  
o Ubuntu 64 bit  

• VCPUs. Select how many Virtual Central Processing Units (VCPUs) to install in the Virtual 
Machine. You may either move the slider to select or enter a number in the. The 
slider/box does not let you select an amount that exceeds the allocations assigned to you. 
You may choose either 1, 2, 4, or 8 VCPUs when creating a configuration.  

• Memory (RAM). Select how many Gigabytes of RAM to install in the VM. You may either 
move the slider to select or enter a number in the box. The slider/box does not let you 
select an amount that exceeds the allocations assigned to you.  

• Storage. Select the amount of storage you wish to have installed in the VM. Click Edit and 
enter the amount of GB in the Storage Size field.  

Minimum System Requirements 

It is your responsibility to know the Minimum Requirements for the Operating System you intend to 
use. At this time, the hardware sliders are not sensitive to the operating system that you choose and 
will allow you to configure VMs that are below or far beyond the minimum and/or maximum 
requirements for the Operating System and/or the software you intend to run on the VM. Optionally, 
visit these third party sites for information on minimum system requirements for operating systems. 

https://help.phoenixnap.com/Login
https://help.phoenixnap.com/Minimum+System+Requirements+for+Operating+Systems
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• Private and Public IP Addresses. You will automatically be assigned a private IP address. 
You need to manage your IPs when creating a VM.  
Note: Every VM must have a Private IP address. This lets the VM communicate with other 
VMs, as well as the public Internet (requires a Public IP address). You may not have more 
than one Private IP address per VM.  

• Tags. Create new or use existing tags.  
• Description. Enter a description for your VM in the text box, if desired. This can help you 

identify VMs and components.  

Click Update to confirm the modifications you made.  

DELETE VM CONFIGURATIONS 

To delete a configuration:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Configurations in the Public Cloud section.  
4. Click the name of a configuration you wish to delete.  
5. Click the Delete icon at the top-right side of the screen.  
6. Click OK to confirm the action.  

CREATE NEW VM CONFIGURATION 

Configurations can be created in two ways. From the Create a VM screen, you can save a VM as a 
Configuration as you are creating the initial VM. If you only want to create the Configuration but not to 
create a VM at this time, you can use the method described on this page.  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click VM Configurations in the Public Cloud section.  
4. Click the Create New icon at the top-left of the screen.  

Select the settings you want to assign each of the following for the configuration:  

• Name. No spaces and/or special characters are allowed in the configuration name.  
• Node. Select one of the existing nodes.  
• Power Status. Use the slider to choose On if you wish VM to be powered on immediately, 

or Off if you are creating the VM for later use and do not need it to be powered on right away.  
• OS & Version. Select the operating system you want to have installed on the VM in the first 

drop-down menu, then select which version of that operating system to install. Available 
operating systemsare:  

• CentOS 64 bit  
• CentOS cPanel Sofaculous 64 bit  
• Microsoft Windows Server 2008  
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• Microsoft Windows Server 2008 Plesk  
• Microsoft Windows Server 2012  
• Red Hat EL 64 bit  
• Ubuntu 64 bit 

  

• VCPUs. Select how many Virtual Central Processing Units (VCPUs) to install in the Virtual 
Machine. You may either move the slider to select or enter a number in the. The slider/box 
does not let you select an amount that exceeds the allocations assigned to you. You may 
choose either 1, 2, 4, or 8 VCPUs when creating a configuration.  

• Memory (RAM). Select how many Gigabytes of RAM to install in the VM. You may either move 
the slider to select or enter a number in the box. The slider/box does not let you select an 
amount that exceeds the allocations assigned to you.  

• Storage. Select the amount of storage you wish to have installed in the VM. Click Edit and 
enter the amount of GB in the Storage Size field.  

• Private and Public IP Addresses. You will automatically be assigned a private IP address. You 
need to manage your IPs when creating a VM.  
Note: Every VM must have a Private IP address. This lets the VM communicate with other 
VMs, as well as the public Internet (requires a Public IP address). You may not have more than 
one Private IP address per VM.  

• Tags. Create new or use existing tags.  
• Description. Enter a description for your VM in the text box, if desired. This can help you 

identify VMs and components. 

Click Save to create a new VM.  

VIRTUAL NETWORK STORAGE 

Virtual Network Storage provides a virtual drive that you can access from your VMs or private computers, 
either using NFS or iSCSI. This offers optimum storage you can access anytime from anywhere. VNS is ideal 
for storing shared documents, backups, and many other applications.  

To access the Virtual Network Storage screen:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Select Virtual Network Storage under the Public Cloud section.  

Minimum System Requirements 

It is your responsibility to know the Minimum Requirements for the Operating System you intend to 
use. At this time, the hardware sliders are not sensitive to the operating system that you choose and 
will allow you to configure VMs that are below or far beyond the minimum and/or maximum 
requirements for the Operating System and/or the software you intend to run on the VM. Optionally, 
visit these third party sites for information on minimum system requirements for operating systems. 

https://help.phoenixnap.com/Minimum+System+Requirements+for+Operating+Systems
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Filter 

To Filter by Node open the drop-down menu. Choose a specific node to view only those Virtual Network 
Storage devices that are assigned to that node.  

View 

You may choose between:  

1. Table  
2. Usage Bar Graph  

Create New Virtual Network Storage 

To create a New Network Storage: 

1. Click the Create New button. 
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2. Select a Node.  
3. Enter a Storage Name.  
4. Choose Volume Type from the drop-down menu.  

• NFS. An NFS server exports one or more of its file systems, known as shares. NFS 
clients can mount these shares on their own file system. You can perform file actions 
on this mounted remote file system as if the file system were local.  

• iSCSI.  
5. Mount Path. Available only if you choose the NFS volume type. Must start with a letter. No 

special characters are allowed, and there's a minimum of 3 characters.  
6. Enter Alias Name. Available only if you choose iSCSI volume type. The initiator alias is 

required, or the provisioning process will not be complete. No special characters allowed.  
7. Enter Volume Size. Limits are set between 50 and 51,200 Gigabytes (GB). 

The Cost icon will be highlighted next to Volume Size. It will give you an 
accurate estimate of how much you will be charged for the configured 
Virtual Network Storage.  

8. Email Alert. Enter a usage percentage in the field (not smaller than 1%) that, when reached, 
triggers an email alert.  
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9. Enter Description (optional).  
10. When you have filled out all the required fields, click Create Network Storage, or click Cancel 

if you wish to discard the configuration.  

Monitor the progress on the Provisioning Tasks screen.  

NETWORK SETTINGS 

Network Settings options in the Client Portal give you options for managing your VM networks. Networks 
are set up by node and are automatically assigned to the standard method whenever a new node becomes 
accessible.  

To reach the Network Settings screen: 

1. Sign in to the Client Portal.  
2. From the Manage mega menu, click the Network Settings link under the Public Cloud section.  
3. Select a Node from the drop-down menu to indicate which node will be edited.  
4. Select a network configuration method. 

 
• Standard. DHCP is enabled, and private IPs are automatically assigned. Mapping is 

automatic upon VM creation and when adding public IPs.  

 

• Advanced. DHCP is enabled, but clients select their own private IP range.  
• Custom. DHCP is disabled, and clients must manually assign Private IPs to VMs and 

create private/public mappings.  

The Standard configuration may not be edited and is provided for review of settings. 

NOTE: Due to the nature of storage arrays, network storage can be increased at any time, however it 
CANNOT be decreased. To decrease the amount of storage, a new (smaller) storage array needs to be 
created and your data migrated. 
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NOTE: Some of the following options will change depending on which option you selected above. If an 
option is mentioned here but does not display on the screen, please move on to the next option. 
Additionally, the DHCP option will display Enabled or Disabled depending on your selection. 

 

5. Enter your Network Storage Private IP.  
6. Enter your Gateway.  
7. Enter your Network Mask.  
8. Enter your DNS Servers, separated by commas with no spaces.  
9. Enter your Private IP Range.  
10. Enter your Lease Time - Default.  
11. Enter your Lease Time - Max Value.  
12. If you have made changes, select Update to save your changes. To discard the changes, select 

Cancel. 

VIRTUAL FIREWALL 

A firewall protects VMs from unauthorized traffic and allows permissible traffic to the VM based upon the 
defined rules.  

Warning! 
Switching from Advanced or Custom to Standard will require you to first delete all the VMs. Please do 
not convert to Advanced or Custom Network Management unless you are certain this setting is needed 
in your organization. 
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Each organization has one firewall. That firewall can be configured to allow and disallow traffic on any 
virtual machine in the organization.  

To access the firewall options:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Virtual Firewalls under the Public Cloud section. 

Working with Firewall Rules 

This screen serves as a list of all your firewall rules and will be necessary when ordering and 
troubleshooting your firewall rules. 

To begin, select an available node from the Select a Node drop-down menu.  

Any time you add a new firewall rule, it appears in this list in the order it was created. You'll notice, 
however, that a Priority column exists on the far left of the list. You need to tell the system in which order 
to process the firewall rules.  

To do this, click Actions in the row of the rule you wish to move, then click Move Up or Move Down at 
the bottom left side of the list.  

Once you've done that, you need to click the Apply Changes link at the top of the Firewall Rules List to 
save your changes.  

Facts about Firewall Rules 

These general rules apply to the firewall:  

• There is no limit to how many rules you can have.  
• If the firewall is off, ALL traffic will be allowed access to your VMs.  
• Only Active rules are looked at by the firewall. Rules set to Not Active will be ignored.  
• When the firewall is off, Active rules are ignored as well.  
• Denies always have priority over Allows. If you have two rules that are identical except for 

the allow/deny, then deny will be given preference, and traffic will be denied.  
• The system has a built-in DENY ALL rule that is processed last but does not show up in the list. 

Once you enable the firewall, you must create “allow” rules to allow traffic to reach your VMs.  
• The system has a built-in load balancer rule that appears as an icon at the top-right of the 

Firewall Rules List. This rule is necessary to ensure your load balancer works as expected no 
matter how many firewall rules exist.  
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Firewall Functions 

Any changes you make on any of the following screens require you to click Apply Changes when you 
return to the Firewall screen after completing the task. Failure to do this will result in the loss of any 
changes you made.  

The following firewall configuration icons display at the top of the screen:  

• Add Rule. Use this link to add a new rule to the firewall.  
• Select a Node.  
• Firewall Status. This link displays differently according to the current state of the firewall. 

Available settings are:  

 
Use Remote Access to block all traffic to all VMs except via ports 22 and 3389, and the 
Console.  

The following actions are available by right-clicking a rule in the list:  

• Delete. Use to delete a rule.  
• Modify. Use to make changes to existing rules.  
• Move Up/Move Down. Use to move the rule up or down in the list of firewall rules.  

ADD RULE 

A firewall needs a set of rules to do its job. Each direction tells the firewall what traffic to allow or deny 
and to which VM to apply that rule. Rules instruct to which ports the traffic goes and what protocols to 
allow.  

When setting up rules, you need to know IP addresses and port numbers for allowing and denying traffic. 
The IP addresses for your VMs (destinations) are in the drop-down menu. 

Here is the list of common port numbers: 

Service Selected Protocol Allowed Destination Port 
Custom  TCP, UDP  Manual  
DNS  TCP, UDP  53 
FTP  TCP  20,21 
FTPS  TCP  989, 990 
HTTP  TCP  80 
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HTTPS  TCP  443 
IMAP  TCP  143 
IMAPS  TCP  993 
LDAP  TCP  389 
MS SQL  TCP  1433, 1434 
MySQL  TCP  3306 
POP3  TCP  110 
POP3S  TCP  995 
RDP  TCP  3389 
SMTP  TCP  25 
SMTPS  TCP  465 
SSH  TCP  22 

To add a new rule:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click the Virtual Firewalls link under the Public Cloud heading.  
4. Click Add Rule.  

 
5. Enter a name for the rule in the Rule Name field. Be as descriptive as possible, this list can 

become extensive.  
6. If you wish the rule to be active immediately, click to select the Rule Enabled checkbox on the 

right side. 
Inactive rules are ignored by the firewall. 

NOTE: No more than 15 ports may be added to any firewall rule's destination or source list.  
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7. Select a rule Type by clicking the slider:  
• ALLOW. Select this option if you are creating a rule to allow traffic from outside 

sources to one of your VMs.  
• DENY. Select this option if you are creating a rule to block traffic from outside sources 

to one of your VMs.  
8. Select a Source/Net Host from the radio buttons:  

• Any Source/Net Host IP. Select this option if you want the rule to apply to any 
source/net host.  

• Specify a Source IP. Use this option to specify the source. Then, enter the source IP 
in the text field. Enter an IP Address in the x.x.x.x format, a range of IP addresses 
formatted without space (x.x.x.1-x.x.x.5), or you can enter a subnet mask formatted 
x.x.x.x/y.  

9. Select an option in the next set of radio buttons labeled ...from this Port:  
• Any. Select this option if you want the rule to apply to any source port.  
• Specify Port/s. Enter a valid port number from 1 to 65535. Use this option to specify 

the source, then enter the port number in the provided field. Multiple ports are 
allowed but make sure to separate port numbers with a comma.  

10. Select a Destination from the ...being sent to radio button set:  
• Any VM, ANY IP.  
• Specify VM. Select this option and click Specify IP. Select a Node, a VM, and an IP 

address from the pop-up wizard. Click OK when complete.  
11. Select a Service from the Using this service drop-down menu (more information about these 

services in the Port Numbers topic).  
12. Select a Protocol (more information about these protocols in the Port Numbers topic).  
13. Select a Destination Port from the drop-down menu:  

• Any. Select this option if you want the rule to apply to any destination port on the 
VM.  

• Specify. Use this option to specify the port, and then enter a port number in the text 
field. Multiple ports are allowed but make sure to separate port numbers with a 
comma.  

14. Enter a port number in the field labeled ...to port/s (more information about these protocols 
in the Port Numbers topic). 

15. Click Add/Update Rule.  
16. Commit the changes immediately by clicking Apply All Changes, or you can continue making 

changes by clicking Make More Rule Changes.  
17. Adjust the priority of your new rule as necessary using Move Up and Move Down in the 

Actions pop-up menu. Alternatively, you can right-click a rule to open the Available Actions 
pop-up menu.  

18. Click Apply Changes at the top of the firewall rules list to save the new rules. 

 

https://help.phoenixnap.com/Port+Number
https://help.phoenixnap.com/Port+Number
https://help.phoenixnap.com/Port+Number
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MODIFY RULE 

To modify an existing rule:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click the Virtual Firewalls link under the Public Cloud heading.  
4. Click Action in the row of the rule you wish to modify.  
5. From the available actions drop-down menu, click Modify.  

 
6. Make the necessary changes and click Add/Update Rule. All the settings configured during 

rule creation can be modified from this screen.  
7. Click Apply All Changes to confirm the modifications.  
8. Click Apply Changes at the top of the firewall rules list to commit the changes.  

DELETE RULE 

To permanently delete a firewall rule:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click the Virtual Firewalls link under the Public Cloud heading.  
4. Click to select the rule you want to modify, then click Delete Rule.  
5. Click Delete Rule again to confirm the deletion.  
6. Click Commit Changes on the firewall screen to save the new rules.  

ENABLE OR DISABLE THE FIREWALL 

Enable 

The firewall is disabled on your account by default.  

“Deny All” Rule 
The Firewall contains a built-in DENY ALL rule, therefore enabling the firewall will deny all access to 
your VMs immediately if you have not already created rules to allow traffic to your VMs. Because of 
this, you may want to add and enable rules before enabling the firewall. 
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To turn the firewall on:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click the Virtual Firewall link under the Public Cloud heading.  
4. Open the Firewall Status drop-down menu and click Enabled.  
5. Click Enable Firewall to confirm your choice.  
6. Click Apply Changes at the top of the Firewall Rules list to commit your changes.  
7. You will receive a confirmation message.  

Disable 

To turn the firewall off:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click the Virtual Firewall link under the Public Cloud heading.  
4. Open the Firewall Status drop-down menu and click Disabled.  
5. Click Disable Firewall to confirm your choice.  
6. Click Apply Changes at the top of the Firewall Rules list to commit your changes.  
7. You will receive a confirmation message.  

REMOTE ACCESS 

Placing a firewall in a Remote Access Only state prevents all traffic except access to port 22 (SSH) and port 
3389 (RDP). Access from the Console is still enabled.  

To place the firewall in Remote Access Only mode:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Virtual Firewalls under the Public Cloud heading.  
4. Open the Firewall Status drop-down menu and choose Remote Access.  

 
5. Click Confirm to confirm your choice to put the firewall in the Remote Access mode.  
6. Click Apply Changes at the top of the Firewall Rules list to commit the changes.  

NOTE: Disabling the Firewall will allow ALL traffic access to your VMs. 
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To turn off remote access, simply Enable or Disable the firewall. 

CLOUD UNIT PRICING 

To reach the Cloud Unit Pricing Screen:  

1. Sign in to Client Portal.  
2. Open the Manage mega menu.  
3. Select Cloud Unit Pricing.  

Here you will find a detailed report of pricing per unit.  

Click the Pricing Profile History link to view various Pricing Profiles for your account. 

How to Check Cloud Unit Pricing? 

To check Cloud Unit Pricing:  

• Choose a node on the Cloud Unit Pricing screen by clicking a node icon. A pricing list for all 
cloud units will open.  

• To check the pricing of every unit in the offer, click Expand All.  
• To inspect the pricing of specific units only, click the desired categories from the list.  

 

All amounts are expressed in US dollars (USD). 

Remote Access 
Remote Access can be enabled by the system without any interaction from any user if a VM is made 
publicly accessible and your firewall is turned off. Users with admin rights can set the firewall back to 
off after the change has been made. 
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ALLOCATION LIMITS 

The Cloud Allocation Limits screen shows you the limits of your physical resources.  

To reach this page:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Allocation Limits under the Public Cloud heading.  

The usage is graphically represented with three status bars:  

1. #VCPUs. The total number of virtual CPU cores that may be used by VMs. Usage is represented 
graphically but also expressed in numbers.  

2. Memory (RAM). The total amount of RAM memory that may be used by VMs.  
3. VM Storage. The total amount of storage room (expressed in gigabytes) that may be used by 

VMs.  

 

 

 

NOTE: Network Storage of the node is declared, but without a usage bar. 
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VIRTUAL PRIVATE DATA CENTER 

PhoenixNAP VPDC is a VMware® vCloud based service with rapid deployment capabilities. Customers can 
check their VPDC capabilities using the Client Portal. 

VPDC Page 

To reach the VPDC page:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Virtual Data Centers under the Virtual Private Data Center heading.  

Use the Filter by Location feature to select one of the available locations:  

1. All  
2. Phoenix, AZ  
3. Ashburn, VA  
4. Amsterdam, NE 
5. Belgrade, Serbia 
6. Singapore 

 

You will be notified if you don't have a Virtual Data Center established at a particular location.  

 

VPDC Listing 

The VPDC listing will display the following information:  

• Data Center Name.  
• Location.  
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• Processor  
o Used/Total. The top bar displays used processor resources and the total amount of 

your processor resources at a given data center.  
o Permanent/Burst. The bottom bar displays the amount of your permanent processor 

resources as opposed to the total amount of your burst processor resources.  
• Memory.  

o Used/Total. The top bar displays used memory resources and the total amount of 
your memory resource at a given data center.  

o Permanent/Burst. The bottom bar displays the amount of your permanent memory 
resources as opposed to the total amount of your memory resources.  

• Storage.  
o Used/Total. The top bar displays used storage resources and the total amount of your 

storage resource at a given data center.  
o Permanent/Burst. The bottom bar displays the amount of your permanent storage 

resources as opposed to the total amount of your storage resources.  

Modify Resource Usage Thresholds 

The usage of your VPDC resources is illustrated with a progress bar. The top bars display the Used vs. Total 
amount of a resource, while the bottom bars display your Permanent vs. Burst resources. The usage bar 
is green by default until usage reaches a certain threshold:  

• At 80% used quota, the progress bar changes orange (Warning threshold).  
• At 95% used quota, the progress bar changes red (Critical threshold).  

To set up different thresholds:  

1. Click the Modify Usage Thresholds link in the upper-right corner of the page.  
2. Select a virtual data center from the drop-down menu or select to create a Custom Threshold 

Profile that will be applied to all your VPDCs.  
3. Modify threshold values as desired.  
4. Click Update to confirm the changes you made.  
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To reset the thresholds, click the Reset thresholds to system default values link at the bottom of the pop-
up window. 

Modify Resources 

1. Click the Modify Resources link under the Manage column.  
2. Use the arrow items to increase or decrease a resource.  
3. Click Update to confirm the changes.  

Note: Permanent resource allocation is associated with a contractual obligation. You may not be able to 
decrease these resources below a certain value.  

ADDITIONAL CLOUD SERVICES 

CLOUD BACKUP FOR VEEAM 

To reach the Cloud Backup for Veeam:  

1. Sign in to the Client Portal.  
2. Open the Manage mega menu.  
3. Click Cloud Backup for Veeam under the Additional Cloud Services heading. 
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The Cloud Backup for the Veeam page show you the Storage Summary tab with the usage information.  

Three (3) locations support Veeam Cloud Connect Backup at the moment:   

• Phoenix, Arizona  
• Amsterdam, Netherlands  
• Ashburn, Virginia  
• Atlanta, Georgia 
• Singapore, Southeast Asia 

Select the location where you have a repository established, and you will be presented with the storage 
summary for that location. 

 

Modifying Storage Allocation 

To increase or decrease your backup storage:  

1. Select a location.  
2. Click Modify located next to Burst Storage to increase your storage quota. To increase 

Permanent Storage, you need to contact your seller. Click Order Info for more information.   

No Backup Repository? 
If you have no backup services powered by Veeam yet or would like to establish another repository, 
please contact Support by dialing 1.855.330.1509 
To learn how to add phoenixNAP as a service provider within the Veeam Backup and Replication 
console click here. 

https://help.phoenixnap.com/Veeam+Cloud+Connect%3A+Adding+phoenixNAP+as+a+Service+Provider
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3. Enter a value in the numeric field or use the spinner next to the field to increase storage. Click 
Reset if you want to set the number to the original value. The pie chart on the right reflects 
the changes as you make them. 

4. Click Update Storage to confirm the changes you made.  

Note that increasing Burst Storage up to 10TB per request occurs automatically. 

 

When increasing your storage quota more than 10TB at a time, you will receive a notification via email 
when your new storage space is put into effect. 

OBJECT STORAGE 

PhoenixNAP's Object Storage Service has been fully integrated with PNCP.  

To open the Object Storage Service console:  

1. Click Manage.  
2. Select the Object Storage link under the Combined Functions heading.  

Object Storage Service Login link: https://objectstorage.phoenixnap.com/console/login.htm  

To find out more about our latest offering, Object Storage Service, follow these links:  

Permanent and Burst Storage 

• Permanent storage is what you contractually request (10 TB/month minimum). It is 
always at your disposal, and it cannot be modified as swiftly as Burst storage. (Permanent 
storage is associated with a contractual obligation.)  

• Burst storage can be added swiftly and removed on demand, and it is more expensive. 
However, burst storage can be acquired monthly, making it the best solution when you 
need more backup storage as quickly as possible.  

 

https://objectstorage.phoenixnap.com/console/login.htm
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• Object Storage Service FAQ  
• Object Storage Service  

 

 

REPORTS 

Reports allow you to view a summary of actions, usage, and allocations in an easily searchable format. 
The following reports are available to you in the Client Portal:  

• Action Log. The action log displays a list of actions users perform, such as creating VMs or 
adding a new user. The list is customizable by date range and can be filtered using a variety 
of options.  

• Allocation. The allocation report displays the allocated hardware as well as the percentage of 
your allocations currently in use.  

• Billing. The billing report provides you with a summary of your bill. It shows how many 
consumable items you used during the billing cycle (VCPUs, Operating Systems, Backups, IP 
addresses, and other items you are billed for using). The report also itemizes the costs for 
those consumables.  

• Usage. The Usage Report displays what is currently in use by each VM, including RAM, VCPUs, 
OS, Backup, and the number of IPs.  

Sorting the Reports 

The reports are sorted by date/time stamp and arranged in ascending order, oldest first. At this time, 
there is no way to sort the columns further within the report, but you may export the report and 
manipulate the data in a third-party program. 

Exporting the Reports 

Most reports can be exported so that you can access them later. After running a report, click the Export 
Report icon at the top-right section of the report and follow the prompts to save an Excel or CSV file to 
your computer. 

ACTION LOG 

The action log provides a list of actions that have happened on an account, including VM creations, 
deletions, and modifications, pricing updates, user creation/modification, and other actions.  

To view the action log:  

1. Sign in to the Client Portal.  
2. Click the Reports link.  
3. Select Action Log.  

https://help.phoenixnap.com/Object+Storage+Service+FAQ
https://phoenixnap.com/object-storage-service
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4. In the Timeframe box on the left, choose from the following:  
• Last 24h. Click this link to run the report for a 24-hour timeframe.  
• Yesterday. Click this link to run the report for the prior day, beginning at 12:00:01 

a.m. and ending at midnight, Mountain Standard Time (Arizona). This is the default 
selection.  

• Last Week. Click this link to run the report for the prior week, beginning at 12:00:01 
a.m. Sunday and ending at 11:59:59 p.m. on Saturday, Mountain Standard Time 
(Arizona).  

• Last Month. Click this link to run the report for the prior month, beginning at 12:00:01 
a.m. on the first day of the month and ending at 11:59:59 p.m. on the last day of the 
month, Mountain Standard Time (Arizona).  

• Alternatively, you may enter a custom date range in the From and To fields using the 
format MM/DD/YYYY HH:MM [AM/PM].  

5. Use the Filter to limit the displayed actions, choose from these options:  
• All. Displays all actions that match the settings chosen in previous fields.  

• My Account did to other accounts. Displays all actions that match the settings chosen 
in previous fields AND are actions that a user from your own account performed on 
another account (not your own).  
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• Other accounts did to my account. Displays all actions that match the settings chosen 
in previous fields AND are actions that a user from another account performed on 
your own account.  

• Actions I did to my own account. Displays all actions that match the settings chosen 
in previous fields AND are actions that you performed on your own account.  

7. Click Run Report.  

 

Actions 

Some of the actions that can be seen in this report are:  

• New Account Created  
• New Domain Added  
• Account Profile Modified  
• New User Created  
• User Profile Modified  
• User Deactivated  
• User Reactivated  
• Account Suspended  
• Account Deactivated  
• Account Reactivated  
• New Pricing Profile Created  
• Pricing Profile Assigned to Org  
• Resource Allocation Changed  
• Ownership Transferred  
• VM Powered Off - Guest OS (User)  
• VM Powered Off - Guest OS (System)  
• VM Powered Off - Forced (User)  
• VM Powered Off - Forced (System)  
• VM Powered On - (User)  
• VM Powered On - (System)  
• New CSS File Uploaded  
• VM Created  
• VM Modified - VCPU, RAM, or Storage  
• Public IP Address Added to VM  
• Public IP Address Removed From VM  
• Firewall Turned On  
• Firewall Turned Off  
• Firewall Set to Remote Access Only  
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• Firewall Rules Modified  
• VM Rebooted (Only shows up if a VM is rebooted from the Client Portal Portal, not if 

performed by logging in to the VM to reboot.)  
• VM Deleted  
• VM Cloned  
• VM Configuration Created  
• VM Consoled  
• Load Balancer Pool Created  
• Load Balancer Pool Modified  
• Load Balancer Pool Deleted  
• Reserved IP Removed  
• Reserved IP Added  
• Image Node Transfer  
• Image Library Upload Failure  
• Export to Image Library Successful  
• Image Library Upload Successful  
 

 

ALLOCATION 

The Allocation screen shows the amount of current and past hardware resources assigned to you.  

To view the allocation report:  

1. Sign in to the Client Portal.  
2. Click the Reports link.  
3. In the drop-down menu, select Allocation.  
4. Select the Node(s) you wish to run a report for.  

NOTE: Some of the actions will offer additional data reports. If there is a View Report link next to an 
action, click the link to view the information. 
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5. In the Timeframe box on the left, choose from the following:  

• Last 24h. Click this link to run the report for a 24-hour timeframe.  
• Yesterday. Click this link to run the report for the prior day, beginning at 12:00:01 a.m. 

and ending at midnight, Mountain Standard Time (Arizona). This is the default selection.  
• Last Week. Click this link to run the report for the prior week, beginning at 12:00:01 a.m. 

Sunday and ending at 11:59:59 p.m. on Saturday, Mountain Standard Time (Arizona).  
• Last Month. Click this link to run the report for the prior month, beginning at 12:00:01 

a.m. on the first day of the month and ending at 11:59:59 p.m. on the last day of the 
month, Mountain Standard Time (Arizona).  

• Alternatively, you may enter a custom date range in the From and To fields using the 
format MM/DD/YYYY HH:MM [AM/PM].  

6. Click Run Report.  

Columns 

The following data columns are available in this report:  

• Node Name  
• Node ID  
• VM. The name of the VM the dataset refers to. The VM name is a hot link; click it to expand 

the dataset for the VM and to populate the rest of the columns.  
• From and To. These columns indicate the date/time range the VM dataset refers to. This 

dataset begins and ends when changes are made to the VM, and only displays data existing 

NOTE: This report only displays virtual resources’ data. 
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within the data range selected when running the report. The From column indicates the date 
a dataset status began. The To column indicates the end date for the dataset's status.  

• Power  
• VCPU  
• RAM (GB)  
• Primary Storage (GB)  
• Secondary Storage (GB)  
• OS  
• Public IPs  

BILLING 

To open the billing screen:  

1. Sign in to the Client Portal.  
2. Click the Reports link.  
3. In the drop-down menu, select Billing.  
4. Click to select the Nodes to report on.  

 
5. In the Timeframe box on the left, choose from the following:  

• Last 24h. Click this link to run the report for a 24-hour timeframe.  
• Yesterday. Click this link to run the report for the prior day, beginning at 12:00:01 a.m. 

and ending at midnight, Mountain Standard Time (Arizona). This is the default selection.  
• Last Week. Click this link to run the report for the prior week, beginning at 12:00:01 a.m. 

Sunday and ending at 11:59:59 p.m. on Saturday, Mountain Standard Time (Arizona).  
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• Last Month. Click this link to run the report for the prior month, beginning at 12:00:01 
a.m. on the first day of the month and ending at 11:59:59 p.m. on the last day of the 
month, Mountain Standard Time (Arizona).  

• Alternatively, you may enter a custom date range in the From and To fields using the 
format MM/DD/YYYY HH:MM [AM/PM] 

7. Click Run Report.  

USAGE 

The Usage report is designed to give you an overview of the VMs in use during a date range. The report 
provide a summary of each VM’s usage of billable services such as Power, VCPU, RAM, and Operating 
Systems.  

To access the Usage Report:  

1. Sign in to the Client Portal.  
2. Click the Reports tab.  
3. In the drop-down menu, select Usage.  
4. Click to select the Nodes to report on. 

 
 

NOTE: This report usually updates every two hours. If you run a report and the timeframe ends within 
the last two hours, your report may be slightly off, usually just a matter of a few cents. We recommend 
running the billing report for a timeframe at least two hours after that timeframe ends. 
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5. In the Timeframe box on the left, choose from the following:  
• Last 24h. Click this link to run the report for a 24-hour timeframe.  
• Yesterday. Click this link to run the report for the prior day, beginning at 12:00:01 

a.m. and ending at midnight, Mountain Standard Time (Arizona). This is the default 
selection.  

• Last Week. Click this link to run the report for the prior week, beginning at 12:00:01 
a.m. Sunday and ending at 11:59:59 p.m. on Saturday, Mountain Standard Time 
(Arizona).  

• Last Month. Click this link to run the report for the prior month, beginning at 12:00:01 
a.m. on the first day of the month and ending at 11:59:59 p.m. on the last day of the 
month, Mountain Standard Time (Arizona).  

• Alternatively, you may enter a custom date range in the From and To fields using the 
format MM/DD/YYYY HH:MM [AM/PM]. 

Columns 

The only populated column upon the first completed report displays will be the VM column. The rest of 
the columns only display after you click one of the VMs in the list to expand it, as there can be more than 
one row of data per VM, broken out by date range.  

The following data columns are available in this report:  

• Node Name  
• Node ID  
• VM. The name of the VM the dataset refers to. The VM name is a hot link; click it to expand 

the dataset for the VM and to populate the rest of the columns.  
• From and To. These columns indicate the date/time range the VM dataset refers to. This 

dataset begins and ends when changes are made to the VM, and only displays data existing 
within the data range selected when running the report. The From column indicates the date 
a dataset status began. The To column indicates the end date for the dataset's status.  

• Power  
• VCPU  
• RAM (GB)  
• Storage (GB)  
• OS  
• Public IPs  
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MY ACCOUNT 

This section of the Client Portal provides information on the administrative tools used to maintain your 
account and any accounts under you.  

ACCOUNT PROFILE 

The Account Profile displays the account details for your organization and provides access to editing 
functionality for some of the information.  

To access the Account Profile:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click Account Profile.  

 

Included Information 

Most of the following information can be modified by clicking the Edit icon.  

• Current Status. Click the Explain Status link for a more in-depth explanation.  
• Network Connectivity.  
• Account ID. The ID assigned to your organization by the system. This cannot be edited.  
• Client Assigned ID. If a Client Assigned ID exists, it will display here.  
• Name (Account). The name of the organization as it appears in the system's official records.  
• Account Email.  
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• Type. The account type, end user in this case.  
• Primary Contact Name.  
• Primary Email. Usually, the same as account email.  
• Primary Phone.  
• Technical Contact Name. The name of the person in charge of the technical details of the 

account.  
• Technical Contact Phone. The contact phone of the person in charge of the technical details 

of the account.  
• Technical Contact Email.  
• Client Of. The name of your provider. By default, your provider will be phoenixNAP.  
• Sign Up Date. The date your service was first activated.  
• Password Phrase or Ubersmith Password Phrase. The password phrase that has been set up 

for the account. This is used for support purposes and should be given to your vendor 
whenever you make contact by phone, email, or chat.  

• Application Key. Empty if you are not using external API. 
• Shared Secret. Empty if you are not using external API 
• 'Create VM' Email. If you choose Yes when a new VM is created, a notification email will be 

sent. Click No if you wish to disable this option.  
Click Update when you are done making the changes or click Reset to revert the changes. 

USER PROFILES 

The User Profiles area lets you create new admin users, modify existing admin users, and change the 
passwords of existing admin users within your organization.  

To access the User Profiles area of the admin:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click User Profiles.  
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When the screen loads, the list shows all existing users.  

 

The data contains the following columns:  

• First Name  
• Last Name  
• Login Email  
• Contact Email  
• User Role. (One of the predefined RBAC user roles.)  
• Status. Active or Not Active.  
• Manage. 'Actions' link. 

Available Actions 

Add a New User. Allows you to create a new user for your organization from scratch.  

By clicking the Actions link under the Manage column, three actions are available:  

• Modify User. Allows you to make changes to an existing user profile, such as changing the 
contact email address or user role.  

• Reset Password. Allows you to change the password for the user.  
• View Assigned Roles and Permissions. For more information on user roles and permissions, 

refer to the User Roles section of the user manual. 

NOTE: Users are automatically set to Not Active after 6 months of inactivity (not signing in) and will be 
prevented from signing in. 
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ADD NEW USER 

To add a new user:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click User Profiles.  
4. Click the Add New User button.  

 
5. Insert the necessary information in the available fields: 

• Status. Active or Not Active.  
• First Name / Last Name.  
• Login Email. Enter the user's login email.  
• Contact Email. Enter the contact email address of the user.  
• New Password. Enter the password the user will use to sign in to the phoenixNAP 

Client Portal.  
• Re-enter Password. Re-enter the password the user will use to sign in to the 

phoenixNAP Client Portal.  
• User Role: Select one of six (6) predefined user roles.  

 
6. Click OK to save the new user information. 

NOTE: The login email cannot be changed later. 
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MODIFY USER 

To modify a user:       

1. Sign in to the Client Portal.  
2. Click My Account > User Profiles.  
3. On the User Profiles screen, locate the user requiring an update.  
4. Click the Actions link under the Manage heading.  
5. Click Modify User.  
6. Make any necessary changes to the available fields. Login email and User ID cannot be 

changed. 
7. Click Update to commit your changes. 

RESET PASSWORD  

To reset your password:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  

NOTE: You will need to contact Support for your Username and Password; for security purposes, this 
information is not sent in the welcome email. 

 

 



©2021, phoenixNAP, LLC 

 

Page 97 of 124 

 

3. Click the User Profiles.  
4. On the User Profiles screen, locate the user requiring a password reset. 
5. Click the Actions link under the Manage heading.  
6. Click Reset Password. 

 

7. Type in the new password and confirm it by re-typing it in the Re-enter Password field.  

 

8. Click Update to apply the changes. 
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USER ROLES 

The Client Portal User Roles feature is a sophisticated Role-Based Access Control (RBAC) system used to 
regulate access* to PNCP users. When appropriately used, RBAC enables you to carry out complex access 
schemes for your users.  

To reach the User Roles page:  

1. Log in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click User Roles.  

*Access is defined as the user's ability to perform specific view, create and/or modify tasks in the Client 
Portal.  

What is RBAC? 

Role-Based Access Control (RBAC) is a secure method of restricting access to authorized users. It is a useful 
tool that allows organizations to have greater control over their PNCP account through the Segregation 
of Duties (SoD). It ensures that only appropriate users can see and access functions they are experts in 
and prohibits users from accessing parts of the system that are not under their job role. The Account 
Manager assigns users to specific roles, where each role defines permission-levels. This ensures that every 
user has access according to their level of knowledge and authority.  

Roles, Permissions, and Users  

• Permissions are assigned to roles. Click Actions > View Permissions to see a list of 
permissions associated with a specific role.  

• Users are assigned to roles. Click Actions > View Assigned Users to see a list of users assigned 
to a specific role.  

What is RBAC useful for? 

RBAC is useful when you need to:  

1. Restrict the number of users with write permissions.  
2. Assign access to users according to their position in your organization.  
3. Configure permissions that reflect the level of knowledge of each user.  

Available User Roles 

Each predefined PNCP role is purposely built so that the most common business roles are immediately 
catered for.  

NOTE: Every user is required to have an assigned role. One (1) role can be assigned per user.  
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• Account Manager. Grants access for the user to change 
account-wide settings, create and modify accounts, and 
manage users.  

• Administrator. A privileged role that provides a 
“superuser” level of permissions. It is also automatically 
granted to the first user created on a new account.  

• Billing Manager. A role that provides access to billing 
and payment features and reports as well as some basic 
read-only access to the account’s PNAP services 
infrastructure.  

• Read Only. Grants access to view all features in the 
account but not to make any changes or create any new 
resources.  

• System Administrator. This role is designed for users 
who manage existing VMs or Bare Metal infrastructure, 
allowing them to console into the devices, reboot them, 
and similar. It does not allow the user to create or delete 
any devices.  

• Technical Manager. A role that grants access to 
technical features such as creating VMs and Bare Metal 
servers, setting Public Cloud firewall rules and Load 
Balancer pools, and similar. Technical Managers can also 
perform all the actions of a System Administrator.  

Manage Users 

To manage users and roles, click the Actions link in the row of the role you want to manage. Possible 
Actions include:  

 

NOTE: Please note that each user can only be assigned ONE role. It is NOT possible to assign several 
roles to one user. 
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• View Permissions. Select to get a list of permissions associated with each role. You can search 
for permissions or expand all categories.  

 

• Assign Users. Select users to be assigned to a role. Click Assign after you have selected the 
users.  
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• View Assigned Users. View the list of users assigned to a role. Use the search field to look up 
a user.  
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BILLING (INVOICES) 

To reach the billing screen:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click Billing.  

 

To change the sorting of the list, click the column name.  

List 

On the billing screen, you can view a list of your invoices and credits. From the drop-down menu in the 
upper-left corner, choose View Invoices or Credits.  
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Invoices 

Filter the list of Invoices by opening the drop-down menu in the upper-right corner. You can select:  

• Unpaid  
• Paid  
• All  

Credits 

Filter the list of Credits by opening the drop-down menu in the upper-right corner, from which you can 
select:  

• Current Credits  
• All Credits  

CHECK BALANCE 

To view your balance:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click Billing.  
4. Click View Invoice in the row of the invoice you want to inspect. Alternatively, you can click 

the invoice number. This action opens a new window with the invoice summary.  
• PDF. Download the invoice as a PDF file.  
• CSV. Download the invoice as a CSV file. 

UNPAID INVOICES 

To view your unpaid invoices and make a payment, follow these steps:  

1. On the billing screen, choose Unpaid from the drop-down menu at the top right, labeled View.  
2. Locate the invoice you wish to pay.  
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3. Click Pay Online in the last column of the invoice. You can also view the invoice and pay from 
that screen.  

4. Choose Payment Type from the drop-down menu:  
• CCBill. Enter your total payment amount or click the Pay Invoice in Full checkbox. Click 

Pay Invoice. 
o Select CCBill if you do not have any credit card information stored in the 

system prior to the December 2016 billing update.  
o Select Pay with Existing Card if you want to pay with a credit card used prior 

to the December 2016 billing update.  
• PayPal. Enter your total payment amount or click the Pay Invoice in Full checkbox. 

Click Pay Invoice. Follow your normal PayPal procedures to complete a payment using 
this method.  

 

MY CUSTOM / CONTRACT PRICING 

The Custom / Contract Pricing section is a searchable table of your existing contracts. This page also 
includes any addendums to your contracts.  

To access the My Custom / Contract Pricing page: 

1. Log in to the Client Portal.  
2. Navigate to the My Account mega menu. 
3. Select My Custom / Contract Pricing. 

 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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4. The page loads a table with your contracts. Use the search bar to locate a contract if your list is 
extensive. 

 

The table contains the following columns: 

• Contract ID. A unique ID of your contract.  
• Addendum/s. The number of addendums attached to your contract.  
• Added in PNCP. The date when the contract was added to the Client Portal.  
• Updated in PNCP. The date when the contract was updated in the Client Portal.  
• Details. The link that loads the Contract Details page with the detailed information for the 

selected contract.   

VIEW CONTRACT DETAILS 

To view pricing details for a contract:  

1. Log in to the Client Portal.  
2. Navigate to the My Account mega menu. 
3. Select My Custom / Contract Pricing. 
4. Click the Details link in the last column for the server in question. 

 

The Custom / Contract Pricing page loads. It contains the following sections: 

1. General Contract Info. This section shows the Sales Persons’ names as well as the contract 
creation and update date and time.  

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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2. Products Added to the Contract. This table lists all products with data center locations for the 
contract. The Details link takes you to the Location Management screen, where you can see 
additional location information for the selected product.  

3. Addendums to this Contract. If there are addendums to your contract, this section will show 
them. You can view an addendum by clicking the link.  

 

To return to the My Custom / Contract Pricing screen, click the Return to Results List link.  

 

LOCATION MANAGEMENT 

To view the location and more details for a product on a contract: 

1. Log in to the Client Portal.  
2. Navigate to the My Account mega menu. 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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3. Select My Custom / Contract Pricing. 
4. Click the Details link in the last column for the contract in question. 
5. Click Details again for the server you want to load location details.  
6. Select a location and click View.   

 

The Location Management screen contains the following sections:  

1. Settings. This screen displays order and contract details for the selected location, as well as the 
status of the deployment.  

2. Pricing. This section shows the base pricing and the prices for the selected options for a 
contracted location. The box at the top shows if there are any notes or instructions. 

You can navigate back to the contract details by using the breadcrumb navigation as marked on the image 
above.  

ORDER HISTORY & STATUS 

The Order History & Deployment Status section provides a list of all orders and their status. The list shows 
both contracts and month-to-month purchases.  

To load the Order History & Status page: 

1. Log in to the Client Portal.  

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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2. Navigate to the My Account mega menu. 
3. Select Order History & Status. 

 

4. The page shows the table with your past and current products. Use the search bar to locate a 
server if your list is extensive.  
Note that every unique server is listed separately, even if ordered on the same contract or 
form.  

 

The table contains the basic details of your order: 

• Contract ID. Shown only for contracted orders. Not available for month-to-month purchases.  
• Server ID. A value assigned automatically once the server is deployed. Not available while the 

order is in progress.  
• Order ID. A unique ID of your order.  
• Product Description. The description of the product you ordered.  
• Location. The location of a data center where your server is deployed.  
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• Deployment Status. There are three possible statuses: 
o In Progress - represents the server for which the order is still in process: pending 

deployment, waiting for payment, etc.)  
o Active - represents a deployed and actively used server. 
o Cancelled - represents a server for which the order has been cancelled due to a declined 

or unsuccessful payment, failed installation, etc.  
• Deployed On. The date when your server is successfully deployed. The column displays TBD for 

orders in progress.  
• Last Update. The date of the last update for the entry.  
• Details. The link that loads the Order Details page with the detailed information for the selected 

product.  

VIEW ORDER DETAILS 

To view order details for a server: 

1. Log in to the Client Portal.  
2. Navigate to the My Account mega menu. 
3. Select Order History & Status. 
4. Click the Details link in the last column for the server in question.  

 

 

The Order Details page loads. It contains the following sections:  

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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1. Details. This section of the page shows general details regarding the product in question, such 
as description, location, deployed and last update dates, client name and email, etc.  

2. Deployment Status. The status is represented in the form of a progress bar. When a step is 
completed, a green checkmark appears. Please reload the page to check for status updates.  

3. Pricing. The pricing section displays all pricing details for the selected product. Depending on the 
order type, the left side shows either contract details or order details. If any discounts have 
been applied, this table shows that as well.  
On the right side, the product options at the time of purchase are listed along with the pricing 
information.  

To return to the Order History & Deployment status screen, click the Return to Results List link. 
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SERVER ORDERS (LEGACY) 

The Server Orders screen allows you to view a list of your server orders.  

To reach the Server Orders (Legacy) page:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Select Server Orders (Legacy).  

The list will show the following columns: 

• Order Id #. Click the order number to get the order details. 
• Total. The total amount paid in dollars. 
• Order Time. 
• Recent Activity. 

PAYMENT METHODS 

To view or edit Payment Methods:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click Payment Methods.  

You will find a drop-down menu at the upper-left side of the screen. There are two payment options:  

• CCBill  
• PayPal Subscriptions  

CCBILL 

As a trusted leader in global payment processing since 1998, CCBill processes more than a billion dollars 
in transactions each year and is committed to delivering innovative solutions, reliable problem-solving 
techniques, and a myriad of payment options.  

Features of CCBill  

• Supported Payment Cards: Visa, MasterCard, Discover, and JCB  
• Available payment Options Specific for Europe: SEPA Direct Debit, Giropay, and iDEAL  
• Available Currencies: USD, CAD, EUR, GBP, AUD, JPY  
• Additional Payment Options: CCBill Pay  

NOTE: Using CCBill does not incur any additional charges. 

 

 

 

https://kb.ccbill.com/support/CCBill+Account+FAQs
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If you select to pay with CCBill, you are redirected to a secure payment form where you can choose among 
the many different payment options in the offer, including credit cards and CCBill Pay. This consumer tool 
enables you to store up to 25 payment options. 

Switching between Multiple Credit Cards 

If you are using multiple credit cards, please use the Buy with CCBill option. We advise you to create a 
CCBill Pay™ account to store up to 25 payment cards. Select the Pay & Create option to create a CCBill 
Pay™ account and store the payment card option used to make the transaction.  

PAYPAL SUBSCRIPTIONS 

1. Sign in to the Client Portal.  
2. Click My Account > Payment Methods.  
3. From the drop-down menu, choose PayPal Subscriptions.  

Add a PayPal Subscription 

1. On the Payment Methods screen, click the Create PayPal Subscription button.  
2. Choose a billing period and service.  
3. Click Create Subscription.  

 



©2021, phoenixNAP, LLC 

 

Page 113 of 124 

 

Your browser should automatically take you to the Billing Information screen, but if it doesn't, 
click Create Subscription one more time.  

4. You MUST have a PayPal account for this purchase. You have two options:  
• Use an existing PayPal account. Enter your email and password and click Log In. 

Follow regular PayPal procedures to complete the payment using this method.  
• Create a PayPal account. Provide the required information and click Continue.  

SUPPORT TICKETS 

To check the status of your submitted tickets:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Select Support Tickets.  

Alternatively, you can view your submitted tickets on the Client Portal landing page, or by clicking All 
Tickets in the Support drop-down menu. 

Filter 

Filter out tickets in the View drop-down menu:  

• Open/On Hold Tickets  
• Closed Tickets  
• All Tickets  

Search for a Ticket 

To search for a specific ticket:  

• Go to the Support Tickets page.  
• Click the Search for a Ticket link.  
• In the first drop-down menu, choose Ticket Type:  

o Open/On Hold Tickets  
o Open Tickets  
o On Hold Tickets  
o Closed Tickets  
o All Tickets  

• In the second drop-down menu, choose a specifier.  
o Any Field  
o Ticket ID  
o Subject  
o Author  
o Body  
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• Provide specifier detail (e.g., If you chose Ticket ID in the second drop-down menu, enter the 
ID of a ticket you are searching for).  

• Click Search.  

 
 

Ticket List 

The list displays the information about the ticket.  

• Ticket #  
• Subject  
• Author. The user who submitted the ticket.  
• Opened. Time and date when the ticket was created.  
• Updated. Here you can check for any ticket status updates.  
• Priority  
• Assigned. The name of the person assigned to process your request.  
• Department. The department that will deal with the ticket.  
• Type. Open, On Hold, or Closed.  

Click the Ticket # or Subject link to view more details for the ticket. In this window, you can click any the 
available hotlink, such as:  

• Post a Followup. Select this option if you have more information about the problem that the 
Support may have need.  

• Reply/Reply & Quote. Do this to post a reply to comments or messages associated with the 
ticket.  

• Reload Ticket. Use this option to refresh the ticket and view more current data.  
• Ticket Event Log. This option will show you a detailed list of every event associated with the 

ticket.  

SERVICES LISTING 

The Services Listing section shows all the services ever provided to you.  

To reach this screen:  

1. Sign in to the Client Portal.  
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2. Open the My Account mega menu.  
3. Click Services Listing.  

Filter 

You may filter services by choosing a type of service from the View drop-down menu in the upper-right 
corner of the screen.  

 
 

Choose from:  

• Current Services  
• Recurring Services  
• One Time Services  
• All Services  

Screen Info 

On the Services Listing screen, you can find:  

1. Service ID  
2. Service Description  
3. Service Plan  
4. Current Renewal Period. Duration of service. After the expiration date, the service must be 

renewed to remain active.  
5. Cost  
6. Payment Method  
7. Status. Active or Inactive.  

Child Services 
Click the Plus sign (if any) next to a Service ID to see sub-services. 
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2-FACTOR AUTHENTICATION 

Enabling 2-factor authentication adds another layer of security to your Client Portal account. When 
enabled, in addition to providing your username and password, you need to supply a security code to gain 
access. We will send you the verification code you need to enter.  

When 2-factor authentication is not enabled, just log in as you normally would.  

Google Authenticator 

Google Authenticator offers users a two-step authentication procedure using one-time passcodes. To 
enable Google Authenticator 2-Factor Authentication:  

1. Sign in to the Client Portal.  
2. Open the My Account mega menu.  
3. Click 2 Factor Authentication.  
4. See the switch next to Google Authenticator. Toggle the switch to Enabled to activate 2-Factor 

Authentication.  

 

Installing the Google Authenticator App 

1. Depending on your smartphone's OS, download the app from one of the two following links: 
• Android 4.4 or later  
• iOS 5.0 or later  

2. When you first enable 2-Factor Authentication, we will provide you with a QR code. Scan the 
code with the Google Authenticator App you installed on your smartphone OR enter the 
numerical code we provide below the QR code.  

3. The Google Authenticator App generated a code. Enter the code in the appropriate field and 
click Verify.  

Note: you must install the Google Authenticator app on your smartphone before you continue. 

https://play.google.com/store/apps/details?id=com.google.android.apps.authenticator2&hl=en
https://itunes.apple.com/us/app/google-authenticator/id388497605?mt=8
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Logging in with Google 2-Factor Authentication Enabled 

1. Navigate to the login page.  
2. Enter your Email and Password and click Sign In.  
3. You will be prompted to enter the Google Authenticator verification code and complete the 

sign in.  

Control Access to 2-Factor Authentication 

As an Administrator, you can control access to the 2-Factor Authentication feature among the users at 
your company. You may select to:  

• Require Users use 2-factor auth.  
• Enable 2-factor auth as an optional feature.  
• Turn off 2-factor auth. 

NOTE: Please note that after three (3) incorrect entries, the toggle switch returns to Not Enabled and 
you need to start the process again. 

 

 

 

https://admin.phoenixnap.com/wap-pncpadmin-shell/login
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View Users 

Select the View Users tab to see a list of account users and whether they have any 2-factor authentication 
methods enabled.  

 

PRODUCTS AND SERVICES 

The Products & Services tab offers information about phoenixNAP and its wide array of services.  

To reach the Products & Services screen:  

1. Sign in to the Client Portal.  
2. Click the Products & Services tab.  

 

https://help.phoenixnap.com/Login
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Here, you will find the following information:  

• Colocation  
• Bare Metal Server 
• Cloud  
• Hardware Leasing  
• Managed Services  
• Solutions  
• Locations  
• Company Info 

 

 
To keep up with the latest offerings, make sure to check Products & Services in the phoenixNAP Client 
Portal regularly.  

GLOSSARY  

2-Factor Authentication 

An additional layer of security. This feature is powered by Google and, when enabled, after supplying your 
username and password, you are required to supply a security code to gain access.  

Activated 

Used to refer to the status of users. Activated users can log into the UI and use the portal’s functions. The 
opposite is Deactivated.  

Allocation Limits 

The limit of your physical resources (VCPUs, Storage, RAM, etc.)  
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Backup 

An option in the user interface that indicates that the VM should be backed up in case of failure.  

Billing Frequency 

A specific day of the month or a period in days representing the billing period and frequency.  

Clone 

To make an exact copy of a VM that belongs to the same organization. Cloning will copy not only the VM’s 
settings (VCPU, memory, etc.) but also all the installed software and data on the source VM.  

Cluster 

A group of VMs under one vCenter installation.  

Console 

Use the console link to access your device to perform administrative tasks, install software, or perform 
other tasks. The console is a particularly useful tool if your server appears unresponsive.  

Deactivated 

Used to refer to the status of users. Deactivated users can’t log into the UI and can’t use the functions 
there. The opposite is Activated.  

DNS (Domain Name System) 

DNS servers maintain a directory of domain names and translate them to IP addresses.  

Domain Extension 

The notation at the end of a web address that specifies an Internet category or a country code.  

Domain Verification 

The process of verifying the ownership of newly added domains. As the domain admin, you should receive 
a verification email and confirm the verification process. Alternatively, you may verify domain ownership 
via DNS string.  

Firewall 

A networking device that sits between a server and the rest of the Internet that decides what network 
traffic to allow through and what to block based on the rules configured within it.  

Typically, a firewall is used to only allow access to IP addresses and ports that must be used for a server 
to accomplish its task. Traffic going to any port not specifically allowed by a firewall is blocked.  
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Firewall Rules 

A user-configurable set of policies that dictate what traffic the firewall allows to pass through and what 
traffic to block.  

Forward DNS 

A forward DNS lookup will, when supplied with a domain name (for example, google.com), return the IP 
address for the supplied domain.  

Fully Qualified Domain Name (FQDN) 

FQDN is the complete domain name for a specific computer or host on the Internet. It consists of two 
parts: the hostname and the domain name. For example, mymail.example.com. The hostname is mymail, 
which is located within the domain example.com.  

Health Check 

Health Checks ensure that the Load Balancer distributes new requests only to servers that are operating 
and ready to receive them. A health check can return values Healthy or Unhealthy.  

Host 

In terms of virtual machines, the host is the physical machine on which the virtual machine is living. One 
host can support many virtual machines.  

Load Balancer 

A networking device that can distribute workloads among multiple VM’s or physical servers.  

Load Balancer Pool 

A collection of IP addresses that have been identified as possible targets in a load-balanced system. Each 
entry in the pool is an IP address that the load balancer can choose to use to support traffic going to the 
load balancer IP for that particular pool. The IP address does not have to be on the cloud; it can be an IP 
for a cloud VM, an EC2 VM, or even a physical server somewhere.  

Memory (RAM) 

RAM stands for Random Access Memory and is the memory or information storage in a computer that is 
used to store running programs and data.  

Name Server 

A name server is a web server that has DNS software installed. It is a server that is managed by a web 
host, specifically designated for managing the domain names that are associated with all the hosting 
provider's accounts.  
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Powered Off 

Refers to a VM that has been powered down but is still provisioned and, in most cases, able to be powered 
back on. Powered off VMs are billed at a different rate than powered on VMs.  

Powered On 

Refers to a VM that is booted up and running and able to be accessed. In most cases, a Powered on VM 
can be powered off. Powered on VMs are billed at a different rate than Powered Off VMs. 

Private Cloud 

Refers to the virtualized compute and storage resources on an infrastructure dedicated to one user or 
company.  

Private IP 

Refers to connectivity into a private extranet network, which, by its design, emulates the functioning of 
the Internet. We assign one private IP to every VM automatically and customers are allowed to access 
their VMs even if they do not want to make them accessible to the public Internet.  

PTR Record 

PTR records resolve an IP address to a fully qualified domain name (FQDN). They are also called Reverse 
DNS records. PTR records are mainly used to check if the server name is associated with the IP address 
from where the connection was initiated.  

Public Cloud 

Refers to the virtualized compute and/or storage resources on an infrastructure shared between multiple 
users or companies.  

Public IP 

Public IP addresses are addresses assigned to computers and devices so that they can find each other on 
the Internet.  

Read-Only Permissions 

One of two permission levels for users in the UI. Read-Only users can perform read actions.  

Reboot 

Immediately power off and power on a VM. Reboots can be triggered for VMs from the UI.  
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Remote Access 

Virtual firewalls can be placed in a Remote Access Only state, where all traffic is blocked, except access 
port 22 (SSH) and port 3389 (RDP). Access from the console remains enabled.  

Reserved IP Address 

Also known as a "leased IP address". It is an IP that was formerly assigned to a Virtual Machine belonging 
to a customer but was designated to be kept for use on future VMs during the deprovisioning of the VM.  

Reverse DNS 

A reverse DNS lookup is used to look up the domain name for a supplied IP address. This can be a useful 
feature to anyone, but it is practical for those running an outgoing mail server as it can check a sender’s 
address.  

Suspend 

A function that places a user, or a group of users, into a temporary “read-only” mode to resolve potential 
billing, fraud, or other issues. While suspended, the users can’t modify or create any products or 
configurations. The previous set up continues to function as is.  

Tags 

Tags are used to sort your devices into manageable categories and containers. They have no effect on 
how your devices run or how they are billed. They simply make it easier for you to filter and manage your 
devices.  

TTL 

TTL stands for Time to Live and it is a numerical value of how long a DNS record will be cached before it 
needs to be refreshed. The default value is 3600 seconds.  

VCPU 

A virtual CPU assigned to a VM.  

Virtual Firewall 

A virtual firewall behaves like a standard firewall and provides the same security features.  

Virtual Machine (VM) 

A virtual computer/server. A VM always has four main configurable elements — VCPU, memory, storage, 
and operating system. A VM allows other optional services to be used with it (firewall rules, load balancer 
pools, public IP addresses, and a backup option).  
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VM Configuration 

A stored recallable set of configurations for a VM (VCPU, memory, etc.) that a given user can pick when 
creating a new VM to quickly fill out the form and spin up a machine.  

VM Template 

A template created and modified by a client (installed certain software, set up certain configurations, etc.) 
in order to create a VM that is tailored to serve a specific purpose. The client can then use this customized 
VM as a base to create a template to be used to quickly deploy a new VM with the identical custom 
configuration.  

VMWare Tools 

VMWare Tools is an optional set of utilities that enhances the performance of a virtual machine’s guest 
operating system and improves the management of a virtual machine.  

VPDC 

Virtual Private Data Center (VPDC) is a custom virtualized hosting environment based on VMware that 
blends shared and dedicated resources.  
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